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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©April 2010

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.
II



Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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Preface
FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
IV



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range 220W AC/DC Adapter – AC Input 

100 - 240V, 50 - 60Hz DC Output 20V, 11A or 19V, 11.6A).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
V
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place where 
foreign matter or moisture may 
affect the system.

Don’t use or store the computer 
in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
VI
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power until 
you properly shut down all pro-
grams.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VII
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VIII
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. Do not use volatile (petroleum distillates)
or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both 

hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
XI
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XII
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

Cable TV Safety
If you have included a TV Tuner in your purchase option then pay careful attention to the following:

• Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the 
building, as close to the point of cable entry as practical.

• This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part 
I of the Canadian Electrical Code).

• The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner 
module outdoors.
XIV
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio Features, 
& Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Wireless LAN, PC Camera, Bluetooth, TV Tuner and RAID 

modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
• Appendix D Information on the Windows 7 OS.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the remainder of the User’s Manual. You may also find the notes marked with a  of interest
to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows Vista etc.) and applications (e.g. word processing, spreadsheet and database
programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is
not the case, or where you are re-configuring your computer for a different system,
you will find the Windows Vista (with Service Pack 2) and Windows 7 operating sys-
tems are supported.

Note: In order to run Windows Vista and Windows 7 without limitations or decreased
performance, your computer requires a minimum 1GB of system memory (RAM).

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the
Windows OS (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 36).

TV Tuner Module 
Support

Note that the TV Tuner
module (factory) option in
Windows Vista is support-
ed by the Windows Media
Center software which
comes built-in to the Win-
dows Vista Home Premi-
um and Ultimate Editions
only. The Windows Media
Center software comes
built-in to the Windows 7
Home Premium, Profes-
sional and Ultimate Edi-
tions only.

If your purchase includes a
TV Tuner option, and/or
you are re-configuring your
system for a different sys-
tem, you should install the
above Windows editions
only.

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which
includes Service Pack 2) before installing any drivers. Go to the Microsoft website for
download details, or contact your service center.
1 - 4 Overview



Quick Start Guide 1

System Startup
1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
4. Move the left LCD latch towards the unlock position, and move the right latch outwards towards the sides of the 

computer, and hold it in position, to release the top cover.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 120 degrees); use 

the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the 
computer by the lid/LCD).

6. Press the power button to turn the computer on.

Figure 1 - 1 - Opening the Lid/LCD Computer with AC/DC Adapter Plugged-In
System Startup 1 - 5
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Closing the Lid/LCD Panel
Make sure you close the lid/LCD by placing your hand in the middle of the panel, and carefully press down
until the LCD latches click into place (do not exert pressure from the sides of the lid/LCD as this can cause dam-
age to the latches, case or lid/LCD).

Figure 1 - 2 - Closing the Lid/LCD
1 - 6 System Startup
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System Map: LCD Panel Open Figure 1 - 3

LCD Panel Open

1. Optional Built-In 
PC Camera

2. LCD
3. LED Power & 

Communication 
Indicators

4. Built-In 
Microphone

5. LED Status 
Indicators

6. Hot Key Buttons
7. Power Button
8. Keyboard
9. Speakers
10. Game Hot Keys
11. Touchpad & 

Buttons

See Appendix A for a more
detailed description of the
ports & jacks etc.

2

1

6
9

7

4 3

Wireless Device Operation 
Aboard Aircraft

The use of any portable electronic
transmission devices (e.g. WLAN or
Bluetooth) aboard aircraft is usually
prohibited. Make sure any wireless
modules are OFF if you are using
the computer aboard aircraft.

Use the appropriate function key
combination (see Table 1 - 4, on
page 1 - 11) to toggle power to any
wireless modules, and check the
LED indicators to see if any modules
are powered on or not (see Table 1
- 2, on page 1 - 8).

9

11

5

810

3

System Map: LCD Panel Open 1 - 7
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LED Indicators
The two sets of LED indicators (LED Status Indica-
tors and LED Power & Communication Indicators)
on the computer display helpful information about the
current status of the computer.

Table 1 - 1 - LED Status Indicators

Table 1 - 2 - LED Power & Communication Indicators

Icon Color Description

Green Card Reader Activity

Green Hard Disk Activity

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated (to activate 
press Fn & Scr Lk)

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep 
Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached 
Critically Low Power Status

Green The (optional) Wireless LAN 
Module is powered On

Orange The (optional) Bluetooth 
Module is powered On
1 - 8 System Map: LCD Panel Open
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Hot Key Buttons & Game Keys
These buttons give instant access to the default Inter-
net browser and e-mail program, and to a user-defined
application, with one quick button press. To use the
“user-defined application Hot Key Button”, you must
install the driver. See “Application Hot Key” on
page 2 - 8 for configuration instructions.
 

Table 1 - 3- Hot Key Buttons

The two Game Keys on the left of the computer allow
macros to be configured for common keystrokes used
in applications, as long as the driver is installed (see
“Game Keys” on page 2 - 9).

Figure 1 - 4 - Game Key Configuration

Hot Key Function

Activate the Default E-Mail Browser

 Activate the Default Internet Program

Activate the user specified application e.g. 
Microsoft Word or Excel
Hot Key Buttons & Game Keys 1 - 9
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table 1 - 4, on page 1 - 11 for full function key combination details.

Figure 1 - 5 - Keyboard

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Num Lk & Scr Lk

Hold down the Fn Key
and Scr Lk to enable
scroll lock, and check the
LED indicator for status.
Num Lk does not require
an Fn Key press.

Numerical 

Play/Pause Key

Function Keys

NumLk & 
ScrLk Keys

Fn Key

 Keypad 

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 10 Keyboard
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators (see the table below) are available when the hot key
utility is installed (see “HotKey Utility” on page 4 - 7). After installing the driver an icon  will appear in the
taskbar.

Table 1 - 4 - Function/Hot Key Combo Indicators

*Make sure that Wireless is ON in the Windows Mobility Center to ensure proper wireless function key behavior (see page 3 - 11).

Fn Keys Function Fn Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F5/
F6

Volume Decrease/
Increase

Fn + 1 Fan Automatic Control / Full Power Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/
F9

Brightness Decrease/
Increase

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F10 PC Camera Power 

Toggle

Fn + F3 Mute Toggle Fn + F11 *WLAN Module Power 
Toggle

Fn + F4  Sleep Toggle Fn + F12 Bluetooth Module Power 
Toggle
Function/Hot Key Indicators 1 - 11
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System Map: Front & Rear ViewsFigure 1 - 6

Front & Rear Views

1. LCD Latches
2. Consumer 

Infrared 
Transceiver*

3. Line-In Jack
4. S/PDIF-Out Jack
5. Microphone-In 

Jack
6. Headphone-Out 

Jack
7. Speakers
8. Vent/Fan Intake
9. DC-In Jack
10. DVI-Out Port

*Enabled with Optional
TV Tuner Only

See Appendix A for a more
detailed description of the
ports & jacks etc.

1

3

1

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan in-
take(s) while the computer is in use.

6

8 9

7
4 5

7

88

2

10
1 - 12 System Map: Front & Rear Views
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System Map: Left View Figure 1 - 7

Left View

1. HDMI-Out Port
2. e-SATA Port
3. Cable (CATV) 

Antenna Jack*
4. RJ-11 Phone Jack
5. RJ-45 LAN Jack
6. Mini-IEEE 1394 

Port
7. ExpressCard Slot 

(see page 2 - 7)
8. Optical Device 

Drive Bay (for 
DVD Device)

9. 7-in-1 Card 
Reader

*Enabled with Optional
TV Tuner Only

See Appendix A for a more
detailed description of the
ports & jacks etc.

31 52 4
6 7

8
9

Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure
you install the IEEE 1394 filter driver (see page 4 - 6).

7-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick)
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter)

Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

HDMI-Out Port
Note that the HDMI-Out Port supports video and audio signals to attached external dis-
plays (also see “HDMI Audio Configuration” on page B - 14).

e-SATA Port
Install the Intel Matrix Storage driver to display the safe removal icon for e-SATA devices
in the taskbar (see “Intel® Matrix Driver Installation” on page 7 - 44).
System Map: Left View 1 - 13
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Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
1 - 14 System Map: Left View
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System Map: Right & Bottom Views Figure 1 - 8

Right & Bottom 
Views

1. USB Ports
2. Security Lock 

Slot
3. Fan Outlet/Intake
4. Battery 

(Secondary HDD 
Bay - HDD3)

5. Primary HDD 
Bay (HDD1 & 2)

6. Component Bay 
Cover

Overheating

To prevent your comput-
er from overheating
make sure nothing
blocks the vent(s)/fan in-
take(s) while the com-
puter is in use.

1 1 2

4

3
3 33

5

6
Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.
See “Battery Information”
on page 3 - 10 for full in-
structions.
System Map: Right & Bottom Views 1 - 15
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle off Category View.

Figure 1 - 9 - Start Menu & Control Panel

Click here to toggle Category View

 

1 - 16 Windows Vista Start Menu & Control Panel
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Video Features
You can configure display options, from the Display Settings control panel in Windows as long as the appro-
priate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on
page B - 1. To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 10 on page 1 - 18).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 10 on page 1 - 18).
5. Click Advanced Settings (button)  (Figure 1 - 10 on page 1 - 18).
6. Click GeForce..... (tab).
7. Click Start the NVIDIA Control Panel  (Figure 1 - 10 on page 1 - 18) to access the control panel.
8. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA 

Control Panel.

1
2

3

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service
center for the latest details on video cards supported (see “Video Adapter” on page C - 2 for details).
Video Features 1 - 17



Quick Start Guide1

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV (connected to the DVI-Out port/HDMI-Out port) as your display device.

Figure 1 - 10 - Display Settings & NVIDIA Control Panel

Table 1 - 5 - Display Modes Available

NVIDIA Display Mode Description

Single One display device is used.

Clone Both connected displays output the same view

Dualview Both connected displays are treated as separate devices, and act as a virtual desktop

1 2

3

4

1 - 18 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 11 - Power Options

Note: Sleep is the default power saving state in Windows Vista
Power Options 1 - 19
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Chapter 2: Storage Devices, Mouse, Audio & 
Printer
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical Device
• 7-in-1 Card Reader
• ExpressCard Slot
• Application Hot Key
• Game Keys
• TouchPad and Buttons/Mouse
• Audio Features
• Setup for Audio Recording
Overview 2 - 1



Storage Devices, Mouse, Audio & Printer

2
 Hard Disk Drive
The hard disk drive(s) is(are) used to store your data in the computer. The hard
disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives
with a height of 9.5 mm. The primary hard disk bay  is accessible from the bottom
of your computer as seen below, and the secondary hard disk bay  is located under
the battery compartment.

The computer can accommodate up to three hard disks (two in the primary bay, and
one in the secondary bay), and these may be configured in RAID or AHCI modes.

Further details on removing and inserting the hard disk are available in “Upgrading
the Hard Disk Drive(s)” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

 Figure 2 - 1
Hard Disk Bays

1
2

12

1 2
2 - 2 Hard Disk Drive
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting. 

Peripherals must be
connected before you
turn on the system.

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

 Figure 2 - 3
DVD Regions
Optical Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader/ExpressCard” on page 4 - 6).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 4
Left View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

2 - 6 7-in-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34. Make sure you install the Express-
Card driver (see “Card Reader/ExpressCard” on page 4 - 6).

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it (as pictured in the 

generic figure below).

ExpressCard 
Slot Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.

 Figure 2 - 5
Express Card Slot
ExpressCard Slot 2 - 7



Storage Devices, Mouse, Audio & Printer

2
 Application Hot Key
To configure a program to open when the application hot key  button is pressed
(Windows Media Player is the default program), follow the instructions below.

1. Double-click the Hot Key driver icon  in the taskbar.
2. Click Launch user specified application (button) .

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe program exists.
5. Double-Click on the program file or choose Open, and click OK (button).
6. Press the application hot key button  to open the program (as long as the hot 

key driver is running in the taskbar).

Hot Key Driver

Double-click the icon  to
bring up the configuration
menu to define which appli-
cation to open when the ap-
plication hot key button

 is pressed.

Application.exe

You will need to locate the
actual application execut-
able (.exe) file, not just the
shortcut. To find the appli-
cation right-click its short-
cut on the desktop and
click Properties. Click the
shortcut (tab) and see
where the executable file is
located by clicking the
Open File Location (but-
ton).

Figure 2 - 6
Application Hot Key 

Driver

Hot Key Driver Location

If you click the close icon , run the program from
the file location (C:\Program Files (x86)\Hot-
key\Hotkey.exe).
2 - 8 Application Hot Key
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Game Keys
The two game hot keys on the left of the computer allow macros to be configured
for common keystrokes used in applications (the keys can assigned macros for any
program, not only games). To configure the keys follow the instructions below
(make sure you have installed the GameKey Utility driver - see “GameKey Utility”
on page 4 - 7).

1. Run the Game Key Configuration program from the desktop icon  (or from 
C:\Program Files (x86)\Chicony\GameKey\GmKeyCfgUtl.exe).

2. Double-click the button  for the appropriate key (it will turn red ).
3. When the button is red  you may then record the keystrokes to be assigned to 

the Game Key.

4. Click OK.
5. Repeat the procedure for the other Game Key if required.
6. Close the Game Key Configuration window.
7. The keystroke order will be repeated with the appropriate button press in any 

application program.

Figure 2 - 7
Game Key 

Configuration
Game Keys 2 - 9
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. The central button may be configured to
function as you require.

Install the TouchPad driver (see page 4 - 6) and then double-click the TouchPad
driver icon  in the taskbar to configure the functions. You may then configure the
TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your
preferences. The TouchPad may be toggled on/off by means of the Fn + F1 key
combination.

TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may dif-
fer in their vertical scrolling
function in most scrollable
windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the win-
dow. Other versions re-
quire tapping/holding down
the finger at the top right or
bottom right of the Touch-
Pad to scroll the window.

 Figure 2 - 8
Mouse Properties
2 - 10 TouchPad and Buttons/Mouse
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 9
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.

See “HDMI Audio Configuration” on page B - 14 for a description of the audio configuration
when connecting an HDMI supported display device.
Audio Features 2 - 11
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 Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 

and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 

Sound Manager).
3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 

Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

 Figure 2 - 10
Realtek Audio 

Manager - 
Recording Setup
2 - 12 Audio Features
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Setup for 5.1 Surround Sound
To setup your system for 5.1 surround sound you will need to connect the audio ca-
bles to the Line-In and Microphone-In jacks.
1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 

and make sure you are in Classic View.
2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 

Sound Manager).
3. Click Speakers (tab) and click Speaker Configuration (tab).
4. Select 5.1 Speaker from the Speaker Configuration pull-down menu.

 Figure 2 - 11
Speaker 

Configuration

Auto Popup Dialog

You should enable the
auto popup dialog to au-
tomatically detect when a
device has been
plugged-in. If disabled,
double-click connector
settings  and click the
box to enable the auto
popup detection of
plugged-n devices.

Connector Settings
Audio Features 2 - 13
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5. Plug the front speaker cables into the Headphone-Out Jack.
6. Plug in the other cables (you may require an adapter to connect each cable to the 

appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as 
follows:

• Line-In Jack = Rear Speaker Out
• Microphone-In Jack = Center/Subwoofer Speaker Out

7. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on 
page 2 - 13).

8. Click to put a tick in the appropriate box according to the speaker plugged-in (e.g. 
Rear Speaker Out), and then click OK to save the setting.

9. Click OK to exit Realtek HD Audio Manager. 

 Figure 2 - 12
Connected Device 

Auto Popup
2 - 14 Audio Features
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Audio Setup for LCD Monitors/TVs with HDMI Input
Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital
audio decoders. Where this is the case, when playing DVDs in Windows Media
Player, a background noise can occur. If this situation does arise then please follow
the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Double-click Realtek Digital Output.
4. Click Supported Formats (tab).
5. Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
6. Click OK and close the control panels.

 Figure 2 - 13
Sound 

Supported Formats
Audio Features 2 - 15
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
2 - 16 Adding a Printer
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page C - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut
Down hot key button when it is pressed for less than 4 seconds (pressing and holding
the power button for longer than this will force the computer to shut down). Use
Power Options (Hardware and Sound menu) control panel in Windows Vista to
configure this feature (see Figure 3 - 4 on page 3 - 8).

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows Power Plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
Power Plans 3 - 5



Power Management

3

Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

Power Button

The Power Button 
in the Start Menu (in
Classic View use the
Shut Down button )
can be used to send the
computer into a power-
saving state.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down
You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 3
Lock Button Menu
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state.Password 

Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 
Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
3 - 10 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 3 - 6
Windows Mobility 

Center
Make sure that Wireless is ON to ensure proper function key behavior.
Conserving Battery Power 3 - 11
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 8 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Life
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
Battery Life 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
3 - 14 Battery Life
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
Battery Life 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
3 - 16 Battery Life
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID or AHCI Modes” on page 7
- 36).

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer. Table 4 - 1, on
page 4 - 3 lists what you need to install and it is very
important that the drivers are installed in the order
indicated.

Module Driver Installation
The procedures for installing drivers for the WLAN,
PC Camera, TV Tuner and RAID modules are pro-
vided in “Modules” on page 7 - 1. Only install drivers
for modules included in your purchase option. Make
sure any modules (e.g. PC Camera, or WLAN) are ON
before installing the appropriate driver.

Install the Intel Matrix Storage driver to fully support
hard disks in RAID or AHCI modes, to display the
safe removal icon for e-SATA devices in the taskbar
and the Intel Turbo Memory module.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or click Op-
tional (button) to access the Optional driver menu.

If you wish to install the drivers manually see page 4 - 3.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Manual Driver Installation
To install the drivers manually click the Browse CD/
DVD button in the Drivers Installer application and
browse to the executable file in the appropriate driver
folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
7 for instructions.

Table 4 - 1 - Driver Installation

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2
(or a Windows Vista version which includes Service
Pack 2) before installing any drivers. Go to the Mi-
crosoft website for download details, or contact your ser-
vice center.

Driver for Windows Vista SP2 Page

Chipset Page 4 - 5

Video Page 4 - 5

LAN Page 4 - 5

Modem Page 4 - 6

Audio Page 4 - 6

TouchPad Page 4 - 6

Card Reader/ExpressCard Page 4 - 6

IEEE 1394 Filter Page 4 - 6

GameKey Utility Page 4 - 7

HotKey Utility Page 4 - 7

Wireless LAN Module Page 7 - 7

PC Camera Module Page 7 - 25

Consumer Infrared Driver Installation (for TV Tuner 
remote) Page 7 - 34

Intel® Matrix Driver Installation (Install to support 
RAID or AHCI, Intel Turbo Memory and e-SATA port) Page 7 - 44
Driver Installation 4 - 3
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the
driver install procedure), click Cancel to close the
window, and follow the installation procedure.
4 - 4 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

RAID Note: Setting up a RAID, or AHCI mode,
needs to be done prior to installing the Windows OS,
and therefore before installing the other drivers listed
here.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next (or Next > Next).
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes. 
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Driver Installation General Guidelines

The driver installation procedures outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
Driver Installation 4 - 5
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Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is now ready for configuration.

Audio
1. Click 5.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next > Finish.
3. Click Restart Now to restart the computer.
4. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 10.

Card Reader/ExpressCard
1. Click 7.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

IEEE 1394 Filter
1. Click 8.Install 1394 Filter Driver > Yes.
2. Click Install > Finish.

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.
4 - 6 Driver Installation



Drivers & Utilities

4

GameKey Utility
1. Click 9.Install GameKey Utility > Yes.
2. Click Next.
3. Click Finish to restart the computer.
4. See “Game Keys” on page 2 - 9 for configura-

tion instructions.

HotKey Utility
1. Click 10.Install HotKey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
4. See “Application Hot Key” on page 2 - 8 for 

configuration instructions.

Make sure you install the Intel Matrix Storage Man-
ager driver to fully support hard disks in AHCI or
RAID modes (see “Intel® Matrix Driver Installa-
tion” on page 7 - 44). Also install this driver to display
the safe removal icon for e-SATA devices in the task-
bar for the e-SATA port. This driver is also required if
you have included an Intel Turbo Memory module in
your purchase configuration.

5.

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point 
to Settings and click Control Panel).

2. Click Check for updates (Security), or 
double-click Security Center and click 
Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates 

(you need to be connected to the internet).
5. Click Install now (button) to install the 

updates.
Driver Installation 4 - 7
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Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

 

Figure 4 - 3 - Optional Drivers Installer Screen

Wireless LAN
See the appropriate install procedure for your WLAN
module in “Wireless LAN Module” on page 7 - 7.

PC Camera
See the camera instructions in “PC Camera Module”
on page 7 - 25.

Consumer Infrared (for TV Tuner Remote)
See the install procedure in “TV Tuner Module” on
page 7 - 33.

Intel Matrix Storage Manager
Install this driver to fully support hard disks in RAID
or AHCI modes, to display the safe removal icon for
e-SATA devices in the taskbar for the e-SATA port
and the Intel Turbo Memory module (see “Intel®
Matrix Driver Installation” on page 7 - 44 and “Intel
Turbo Memory Module” on page 7 - 48).
4 - 8 Driver Installation
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

Phoenix SecureCore(tm) Desktop

Copyright 1985-2008 Phoenix Technologies Ltd.

All Rights Reserved

Bios Revision: ********

KBC/EC Firmware Revision: ********

CPU = 1 Processors Detected, Cores per Processor = 2

Intel(R) Core(TM) CPU 000 @ 2.93GHz

600K System RAM Passed

1022M Extended RAM Passed

3072 KB L2 Cache

System BIOS shadowed

Video BIOS shadowed

Fixed Disk 0: FUJITSU MHZ2250BH G2

ATAPI CD-ROM: TSSTcorp CDDVDW TS-L633A

Mouse intialized

Press <F2> to enter SETUP

1
2

3

4
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Program
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow next to an item, press Enter to go to a sub-menu on that subject.
The sub-menu screen that appears has a similar layout, but the Enter key may exe-
cute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Program 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

Figure 5 - 1
Main Menu Mai n Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or

<Enter> selects field.

Main

System Time: [22:12:05]

System Date: [03/04/2009]

System Memory: 633 KB

Extended Memory: 2045 MB

BIOS Revision: ********

KBC/EC Firmware Revision: ********

VGA Card: nVIDIA GTX 280M

VBIOS Revision: ********

VBIOS Build Date: ********

Phoenix SecureCore(tm) Setup Utility
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Advanced Menu

Advanced Chipset Control: (Advanced Menu)
This Intel(R) Virtualization Technology and Hyperthreading hardware accelera-
tion technologies may be enabled from this sub-menu. Intel(R) Virtualization Tech-
nology enables a CPU to act as if it were several CPUs working in parallel in order
to allow several operating systems to run at the same time in the same machine. Hy-

Figure 5 - 2
Advanced Menu

Main AAdvanced Security Boot Exit

F1 Help �� Select Item - / + Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Advanced

RAID/AHCI Mode.

Phoenix SecureCore(tm) Setup Utility

             Setup Warning

Setting items on this menu to incorrect

values may cause your system to malfunction.

� Advanced Chipset Control

SATA Mode Selection: [RAID]

Legacy USB Support: [Enabled]

Reset Configuration Data: [No]

Power On Boot Beep [Disabled]

Battery Low Alarm Beep [Disabled]

Boot-time Diagnostic Screen: [Disabled]
Advanced Menu 5 - 7
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perthreading activates additional CPU threads that may appear as additional proces-
sors and is used to improve CPU multi-tasking. The operating system will view a
processor with Hyperthreading enabled as two virtual processors and will spread
any tasks between them (make sure your installed operating system supports multi-
ple processors, and preferably, is optimized for this technology). After enabling/dis-
abling Hyperthreading, and saving and exiting the BIOS, the system will shut down
(press the power button to turn the system on again).

SATA Mode Selection: (Advanced Menu)
Press Enter here to open the sub-menu to choose the configuration of the SATA
mode. You may enable/disable SATA RAID or AHCI mode for your hard disks,
however you should only enable/disable SATA RAID or AHCI BEFORE in-
stalling an operating system, and after you have backed up all necessary files and
data (see sidebar).

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

RAID/AHCI 
Enable/Disable

Warning

DO NOT Enable/Dis-
able SATA RAID or
SATA AHCI unless you
intend to reinstall your
operating system. Make
sure you have backed
up all your data before
doing so.
5 - 8 Advanced Menu
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Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (or POST
screen - see “The Power-On Self Test (POST)” on page 5 - 2).
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBIOS Setup Utility. This will not
affect access to the computer OS, (only the PhoenixBIOS Setup Utility).

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 3
Security Menu

Main Advanced SSeeccuurriittyy Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password

controls access to the

setup utility.

Security

Phoenix SecureCore(tm) Setup Utility

Supervisor Password Is: Clear

Set Supervisor Password [Enter]

Password on boot: [Disabled]
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Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer. If “En-
abled” is selected, only users who enter a correct password can boot the system (see
the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system from the devices
listed in this menu, and in this priority order. If it cannot find the operating system
on that device, it will try to load it from the next device in the order specified in the
Boot priority order. Item specific help on the right is available to help you move
devices up and down the order.

Figure 5 - 4
Boot Menu

Phoenix SecureCore(tm) Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or

configure devices:

Up and Down arrows

select a device.

<+> and <-> moves

the device up or down.

<x> exclude or include

the device to boot.

Boot priority order:
1: USB KEY:
2: USB HDD:
3: PCI SCSI: P0-FUJITSU MHY2120BH
4: PCI BEV: P4-HL-DT-ST DVDRAM GSA-T50
5: PCI BEV: Realtek Boot Agent
6:
7:
8:

Excluded from boot order:
: USB CDROM:
: USB FDC:
:
:
:
:
:

Main Advanced Security Boot Exit
5 - 12 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 5
Exit Menu

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults

Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and

save your changes to

CMOS.

Exit Saving Changes

Exit Discarding Changes

Load Setup Defaults

Discard Changes

Save Changes

Main Advanced Security Boot Exit

Phoenix SecureCore(tm) Setup Utility
Exit Menu 5 - 13
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the System Memory (RAM)
• Upgrading the Optical (CD/DVD) Device(s)
• Upgrading the Video Card
Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Loosen screws  - .
3. Release the battery, and lift the battery  out of the battery bay.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1 3
4

1
2
3

4

Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive(s)
The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA)
hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow
your operating system’s installation instructions, and install all necessary drivers
and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a
new hard disk.

Removing the Hard Disk(s) in the Primary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the bay cover .

RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 - 2
HDD Bay Cover 

Removal

1 4
5

1

32

4

5
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4. Remove screws  -  and pull the tab to release the cable  from the 
connector . 

5. Lift the hard disk assembly out of the computer.
6. Remove screws  -  (if two hard disks are installed).
7. Separate the hard disk(s) from the bracket  and connector cable .
8. Insert the new hard disk(s) into the computer.
9. Re-Insert the bracket and insert screws.

6 8 9
10

11 18
19 20

6

7

8 9

10

16

15
13

14

11

12

18

17

19

20

HDD System Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the discs re-
quired to install your oper-
ating system and
programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 3
Primary HDD 

Removal
Upgrading the Hard Disk Drive(s) 6 - 5
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Removing the Hard Disk(s) in the Secondary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. The secondary hard disk bay is located under the battery compartment.
3. Remove screw .
4. Slide the hard disk assembly in the direction of the arrow .
5. Lift the hard disk assembly  out of the compartment.
6. Remove the screws  -  to release the hard disk from the case.

RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 - 4
Secondary HDD 

Removal

21
22

23
24 27

22

21

23

24

25

27

26
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Upgrading the System Memory (RAM)
The computer has three memory sockets for 204 pin Small Outline Dual In-line
(SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C -
2). The total memory size is automatically detected by the POST routine once you
turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component cover and remove screws  - .
3. Remove the bay cover .

Contact Warning

Be careful not to touch
the metal pins on the
RAM module’s connect-
ing edge. Even the
cleanest hands have
oils which can attract
particles, and degrade
the module’s perfor-
mance.

RAM Module Speeds 

Use either 1066MHz OR
1333MHz DDRIII
(DDR3) modules of the
same brand. Do not mix
DRAM speeds/brands in
order to prevent unex-
pected system behavior.

Figure 6 - 5
Bay Cover Removal

1 10
11

1 32

45
7

6
89

10 11
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4. Remove screws  -  from the RAM fan, and disconnect cable .
5. Remove the RAM fan unit .

Figure 6 - 6
Fan, Heat Sink 
Unit Screws & 

Cable Connectors

Caution

The heat sink, and
CPU area in general,
contains parts which
are subject to high
temperatures. Allow
the area time to cool
before removing these
parts.

12 14 15
16

12
13

14

15

16
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6. Fully loosen screws  -  in the order indicated here (and on the label).
7. Disconnect cable .
8. Carefully (make sure all the screws are sufficiently loosened and cables 

disconnected) remove the heat sink and fan unit .

17  23  
24  

Figure 6 - 7
Heat Sink 
Removal

Caution

The heat sink, and
CPU area in general,
contains parts which
are subject to high
temperatures. Allow
the area time to cool
before removing these
parts.

25  

22

17 18

19 20

21 23
24

25
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9. Gently pull the two release latches (  & ) on the sides of the memory socket in 
the direction indicated by the arrows in Figure 6 - 8

10. The RAM module  will pop-up, and you can remove it.

11. Pull the latches to release the second module if necessary.
12. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory socket.
13. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

14. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.

15. Replace the heat sink unit (make sure you tighten the screws in the order 
indicated on the label and in Figure 6 - 7), RAM fan, cover and screws.

16. Restart the computer to allow the BIOS will register the new memory configuration 
as it starts up.

Single Memory 
Module Installation

If your computer has a sin-
gle memory module, then in-
sert the module into the
Channel 0 (JDIMM2) sock-
et as shown in Figure 6 - 8.

Figure 6 - 8
RAM Module 

Removal

RAM Module Speeds 

Use either 1066MHz OR
1333MHz DDRIII (DDR3)
modules of the same
brand. Do not mix DRAM
speeds/brands in order to
prevent unexpected sys-
tem behavior.

26 27

28

26

27

26

27
28
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Upgrading a Third System Memory (RAM) Module
If you wish to add a third memory module follow the procedure below (note the side-
bar warning on RAM speeds).

1. Turn off the computer, and turn it over and remove the battery.
2. Turn the computer back over to access the keyboard.
3. Press the four keyboard latches  -  at the top of the keyboard to elevate the 

keyboard from its normal position (you may need to use a small screwdriver or pair 
of tweezers to do this).

RAM Module Speeds 

Use either 1066MHz OR
1333MHz DDRIII
(DDR3) modules of the
same brand. Do not mix
DRAM speeds/brands in
order to prevent unex-
pected system behavior.

Figure 6 - 9
Keyboard Latches

1 4

1 32 4
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4. Lift the keyboard up, but be careful not to twist the keyboard ribbon cable .
5. Remove screws  -  and remove the keyboard plate .

Figure 6 - 10
Keyboard Plate 

Screws

Figure 6 - 11
Keyboard Plate 

Removal

5
6 7 8

5

6 7

8

6 - 12 Upgrading the System Memory (RAM)



Upgrading The Computer

6

6. Gently pull the two release latches (  - ) on the sides of the memory socket in 
the direction indicated by the arrows in Figure 6 - 12

7. The RAM module  will pop-up, and you can remove it.

8. Pull the latches to release the second module if necessary.
9. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory socket.
10. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

11. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.

12. Replace the keyboard plate, screws and keyboard.
13. Restart the computer to allow the BIOS will register the new memory configuration 

as it starts up.

Figure 6 - 12
Third RAM Module 

Removal

Contact Warning

Be careful not to touch
the metal pins on the
RAM module’s connect-
ing edge. Even the
cleanest hands have
oils which can attract
particles, and degrade
the module’s perfor-
mance.

9 10

11

9

10

11
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Upgrading the Optical (CD/DVD) Device(s)
1. Turn the computer off, turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the bay cover .
4. Remove screw  and use the screwdriver to push the optical device(s) out of the 

computer at point .

Figure 6 - 13
Removing the CD/

DVD Device(s)

1 4
5

6
7

1

3 2

4

6

7

5
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Upgrading the Video Card
If you intend to upgrade or add another VGA card follow the procedures outlined
here. However please check with your service representative first to make sure your
computer can support more than one video card, and that you are not going to void
your warranty. Pay careful attention to the alignment of any video card into the slot
on the mainboard.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component cover and remove screws  - .
3. Remove the bay cover .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 14
Bay Cover Screws

1 10
11

1 32

45
7

6
89

10 11

Video Fan
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4. Remove screws  -  from the video card fan and disconnect the fan cable .

5. Remove screws  -  from the heatsink in the order indicated on the label.

12 14 15

12

14

13

15

Figure 6 - 15
Video Card Fan 

Screws

Figure 6 - 16
Heat Sink Screws

16 19

19

18 16

17
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6. Grip the handle and carefully remove the heatsink .
7. Remove screws  &  from the video card.
8. Carefully remove the video card .

20

Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 17
Heatsink & Video 

Card Removal

21 22
23

21 22

20

23
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Installing a New Video Card

1. Prepare to fit the video card into the slot by holding it at about a 30° angle.

2. The card needs to be fully into the slot, and the video card and socket have a 
guide-key and pin which align to allow the card to fit securely.

Contact Warning

Be careful not to touch
the metal pins on the
VGA card’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 18
Video Card 
Insertion
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Upgrading The Computer

6

3. Fit the connectors firmly into the socket, straight and evenly.
4. DO NOT attempt to push one end of the card in ahead of the other.

5. The card’s pin alignment will allow it to only fit one way. Make sure the module is 
seated as far into the socket as it will go (none of the gold colored contact 
should be showing). DO NOT FORCE the card; it should fit without much 
pressure.

Figure 6 - 19
Video Card Insertion 

Procedure
Upgrading the Video Card 6 - 19
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6. Secure the card with screws  &  (Figure 6 - 17 on page 6 - 17).
7. Place the heatsink back on the card, and secure the screws in the order indicated 

in Figure 6 - 16 on page 6 - 16.
8. Attach the video card fan and secure with the screws as indicated in Figure 6 - 15 

on page 6 - 16.
9. Reinsert the component bay cover, and secure with the screws as indicated in 

Figure 6 - 14 on page 6 - 15.

21 22
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Chapter 7: Modules
Overview
This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Bluetooth Module
• Wireless LAN Module
• PC Camera Module
• TV Tuner Module
• Setting Up SATA RAID or AHCI Modes
• Intel Turbo Memory Module
Overview 7 - 1
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Bluetooth Module
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows Vista, and therefore does not require a driver. Use
the Fn + F12 key combination (see Table 1 - 4, on page 1 - 11) to toggle power to
the Bluetooth module (when the Bluetooth module is on, the  LED will be
orange).

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 4, on
page 1 - 11/ Table 1 - 2, on
page 1 - 8).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.

Windows 7 Bluetooth Information

See “Bluetooth Module (Win 7)” on page D - 33 for Windows 7 configuration informa-
tion.
7 - 2 Bluetooth Module
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the task-
bar, access the Blue-
tooth Devices control
panel. Click Bluetooth
Settings > Options, and
make sure that Show the
Bluetooth icon in the
notification area check
box (Connections) has a
tick inside it.

Note that you will need to
check the LED indicator
to see if the module is
powered on or not.

Figure 7 - 1
Bluetooth Devices & 

Click Icon Menu

Bluetooth SettingsAdd Wireless Device
Bluetooth Module 7 - 3
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Bluetooth Settings.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it, and click OK.
3. Click Add Wireless Device in the Bluetooth Devices control panel.
4. Double-click the device you want to pair with the computer.

5. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 2
Pair with a wireless 

device
7 - 4 Bluetooth Module
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6. Enter the code into your Bluetooth enabled device and follow any on-screen 
instructions to complete the pairing.

7. Windows will check to see if any drivers are required to complete the pairing. 
8. Follow any on-screen instructions on the computer if device drivers are required to 

be installed.
9. Click Close.

Figure 7 - 3
Pairing Code 

Example

Figure 7 - 4
Pairing Complete & 
Bluetooth Device 

Enabled

Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
Bluetooth Module 7 - 5
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Bluetooth Settings > Options, and make sure that Allow Bluetooth 

devices to find this computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 5
Bluetooth Settings - 

Options
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) or
802.11b/g WLAN module in your purchase option, make sure that the Wireless LAN
module is on before installing the driver.

Use the Fn + F11 key combination (see Table 1 - 4, on page 1 - 11) to toggle pow-
er to the Wireless LAN module (when the WLAN module is on, the  LED
will be green). Make sure you install the drivers in the order indicated in Table 4 -
1, on page 4 - 3.

The standard driver installation procedure for the Intel® Wi-Fi Link 5100/5300 Se-
ries module is outlined overleaf. If you want to include Intel® My WiFi Technol-
ogy as part of the installation procedure, DO NOT install the driver as per the
instructions overleaf, instead see “Intel® My WiFi Installation & Configuration”
on page 7 - 12.

If you have installed the standard driver (as per the instructions overleaf) and wish
to enable Intel® My WiFi Technology at a later point you will need to reinstall the
driver (choose Unlock from the Drivers Installer menu). Follow the driver installa-
tion procedure and choose Modify from the menu when the option appears, and then
follow the remaining installation instructions in “Intel® My WiFi Installation &
Configuration” on page 7 - 12.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 4, on
page 1 - 11/ Table 1 - 2, on
page 1 - 8).
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Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

802.11b/g Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 6
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 7
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 8
Connecting

Figure 7 - 9
Connection Status
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7. To disconnect from the wireless network you can click the taskbar wireless icon , 
and then select Connect or disconnect to access the network menu, and click 
Disconnect (or right-click the icon , and then click Disconnect from).

Security Enabled 
Networks

You should try to make
sure that any network
you are connecting to is
a secure network.

Connecting to unsecure
networks may allow un-
authorized access to
your computer, docu-
ments, websites and
files etc.

Figure 7 - 10
Disconnecting

Click icon

Right-click icon
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Intel® My WiFi Installation & Configuration
Intel® My WiFi Technology uses your WLAN module to allow you to connect up
to eight other WiFi enabled devices (e.g. digital cameras, other computers, cell
phones, handheld devices etc.) to your computer (similar to Bluetooth), while still
connecting to the Internet through your WiFi wireless connection. Intel® My WiFi
Technology offers greater range and speed than other personal area networks, and
does not require an access point.

Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel
PROSet Wireless > Intel
My WiFi Technology), or
by clicking the taskbar
icon . Click the Help
icon  and select
a help topic from the
Contents menu.
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Intel® Wi-Fi Link 5100/5300 Series My WiFi Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next > Next.
6. Click Custom (button) and click Next.
7. Click Intel(R) My WiFi Technology (button) and select “This feature will 

be installed on local hard drive.”

8. Click Next > Finish.

Intel(R) PROSet/ 
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).

Figure 7 - 11
Intel(R) PRO Set
Intel(R) My WiFi 

Technology 
Installation
Wireless LAN Module 7 - 13



Modules

7

Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

2. Click Enable  (on the first run of the program there will be no connected 
devices listed).

Figure 7 - 12
Intel® My WiFi 

Utility
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3. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

4. Click Network and Sharing Center (Network and Internet). 
5. Click Manage Network Connections. 

6. Right-click Intel My WiFi STA (Station) in Network Connections and select 
Properties.

Figure 7 - 13
Network and 

Sharing Center

Figure 7 - 14
Intel My WiFi STA 

Properties 
(Network 

Connections)

Click Manage Network
Connections 

Right-click Intel My WiFi
STA (Station) and select
Properties. 
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7. Click Sharing (tab) and select “Allow other network users to connect through 
this computer’s Internet connection”.

8. Select Intel My WiFi PAN under Home Networking Connection.
9. Click OK.

Figure 7 - 15
Intel WiFi STA 

Properties - 
Sharing

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Intel My WiFi PAN.
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10. A message will appear to inform you that the LAN adapter will be set to use the IP 
address 192.168.0.1.

11. Click Yes to enable Internet Connection Sharing.

12. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

13. Click Profiles .

Figure 7 - 16
IP Address 

Warning

IP Addresses

The Intel® My WiFi de-
fault gateway IP ad-
dress is 192.168.0.1.
DO NOT use this ad-
dress for any Wireless
Access Point (or any
other static IP address
on your network).

Figure 7 - 17
Intel® My WiFi 

Utility
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14. Click Profiles, click Intel Wireless PAN and click Edit.

15. You can change the Profile Name and Network Name to your personal 
preferences in General (tab).

Figure 7 - 18
IP Address 

Warning

Figure 7 - 19
Intel® My WiFi 

Profile Settings - 
General

Profile and Network Names

The Profile Name is the name as
displayed on your computer in the
Network Connections control pan-
el (see Figure 7 - 14 on page 7 -
15).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.
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16. Click Security (tab).
17. Change the Security Type to WEP and the Encryption Type to 64bit.
18. Enter a password (5 characters long) in the Passphrase box.
19. Click OK. 

Figure 7 - 20
Intel® My WiFi 

Profile Settings - 
Security
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20. Click Sharing (tab).
21. Make sure Filter Network Traffic and DHCP and DNS Server are Disabled.
22. Click OK. 

Figure 7 - 21
Intel® My WiFi 

Profile Settings - 
Sharing

Set Filter Network
Traffic & DHCP
and DNS Servers
to Disabled.
7 - 20 Wireless LAN Module



Modules

7

23. Click Advanced (tab).
24. Make sure the Default Channel is set to Channel 1, 6 or 11.
25. Click OK. 

Figure 7 - 22
Intel® My WiFi 

Profile Settings - 
Advanced
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26. Double-click Intel My WiFi PAN (Personal Area Network) in Network Connections.
27. Click Details to display the Network Connection Details.

Figure 7 - 23
Intel My WiFi PAN 

Network 
Connection Details 

(Network 
Connections)
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28. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

29. To add a new device follow the instructions in the devices’ user guide for 
connecting to a WiFi network.

30. Click Add New Device in Intel® My WiFi Utility to confirm the security settings 
detail.

Figure 7 - 24
Intel® My WiFi 

Utility 
(Add New Device)
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 7 - 25
Windows Mobility 

Center

Make sure that Wireless is ON to ensure proper function key behavior.
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PC Camera Module
The PC Camera module uses the BisonCap application to capture video files. Be-
fore installing the PC Camera driver, make sure that the optional PC Camera is on.
Use the Fn + F10 key combination (see Table 1 - 4, on page 1 - 11) to toggle pow-
er to the PC Camera module. Make sure you install the drivers in the order indi-
cated in Table 4 - 1, on page 4 - 3.

Latest PC Camera 
Driver Information

Check the disc, and any ac-
companying insert pages,
for the latest updated infor-
mation on the PC Camera
driver, which may override
the information provided
here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).

PC Camera Device and TV Module

If you have both an optional PC Camera and an optional TV Tuner module present, you will
need to select which device to use with the BisonCap program. Go to the Devices menu
in the BisonCap application and select the BisonCam, NB Pro device.
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PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install WebCam Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

PC Camera Screen 
Refresh

The PC Camera module
supports a frame rate of
12 fps. If you find that
the screen refresh rate
is subject to lag or stut-
tering, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion. 

To reduce Output Size
and/or Color Space
Compression run the
BisonCap application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate pull-down
menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
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Figure 7 - 26
Audio Setup for PC 

Camera

Right-click
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BisonCap
BisonCap is a video viewer for general purpose video viewing and testing, and for
capturing video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture 
process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 27) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture (you can view the file using the Windows 
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 30 in
order to save file space, and help prevent system problems.

Pre-Allocating File 
Space

You may pre-allocate
the file size (File > Allo-
cate File Space) for the
capture file in the
BisonCap program.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.

See also “Reducing
Video File Size” on
page 7 - 30.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 29), limit the file size of the captured video (see “Pre-
Allocating File Space” on page 7 - 29) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 27
Video Capture Filter
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Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap program.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Figure 7 - 28
Zoom/Setting

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Bison Cap
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TV Tuner Module
If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows Vista (Home
Premium Edition & Ultimate Edition)/Windows 7 (Home Premium Edition, Pro-
fessional & Ultimate Editions). In addition a driver is provided on the Device Driv-
ers & Utilities + User’s Manual disc for the remote control supplied with the TV
Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.

TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please
do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 7 - 29
TV Tuner Ports/

Jacks
1. Consumer Infra-

red Transceiver
2. CATV Antenna 

Jack
2

1
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Consumer Infrared Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install CIR Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by Windows Media Center in 

Windows Vista (Home Premium Edition & Ultimate Edition)/Windows 7 
(Home Premium Edition Professional & Ultimate Editions).

2. Run Windows Media Center directly from the Start menu (Start > Pro-
grams > Windows Media Center).

3. Windows Help and Support provides information on the Windows Media 
Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying 
glass icon  to bring up the results.

TV Tuner Module 
Support

Note that the TV Tuner
module (factory) option in
Windows Vista is support-
ed by the Windows Media
Center software which
comes built-in to the Win-
dows Vista Home Premi-
um and Ultimate Editions
only. The Windows Media
Center software comes
built-in to the Windows 7
Home Premium, Profes-
sional and Ultimate Edi-
tions only.

If your purchase includes a
TV Tuner option, and/or
you are re-configuring your
system for a different sys-
tem, you should install the
above Windows editions
only.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.

CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer’s attention
to Article 820-93 of the
NEC (Section 54, Part I
of the Canadian Electri-
cal Code).
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Setting Up SATA RAID or AHCI Modes
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID
You may use your identical (see sidebar) hard disks (if you have included more than
one hard disk in your purchase option) in combination with Striping (RAID 0), Mir-
roring (RAID 1), Parity Across Disks (RAID 5) or Intel® Rapid Recover Technol-
ogy (Recovery) for fault tolerance and data recovery (see Table 7 - 1, on page 7 -
37). To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes
you will require at least two hard disks; to configure your system in Intel® Rapid
Recover Technology (Recovery) mode you will require two hard disks installed; to
configure your system in Parity Across Disks (RAID 5) mode you will require three
hard disks installed.

Intel® Matrix Storage Manager
Make sure you install the Intel Matrix driver and application if you have set up your
hard disk(s) in AHCI or RAID modes (see “Intel® Matrix Driver Installation” on
page 7 - 44).

RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.
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RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

RAID 5
Identical drives (at least three drives must be used) in a parity across disks 
configuration are used to protect data and increase performance. A RAID 5 array 
can withstand a single disk failure without losing access to data.

Recovery
Two Identical drives copying data between a master and a recovery disk. This provides 
more control over how data is copied between the master and recovery drives, fast 
volume updates and the ability to view the data in Windows Explorer.

Table 7 - 1
RAID Levels

Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.
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Prepare the following before setting up your serial ATA hard disks in RAID mode
(to configure AHCI mode you do not need to prepare any extra hard disks but will
need to install the Intel Matrix driver):

1. The Microsoft Windows OS CD.
2. A second (identical) hard disk installed in the Primary HDD bay for RAID level 0 

or 1 (required for RAID but not required for AHCI).
OR
A second (identical) hard disk installed in the Primary HDD bay, and a third 
(identical) hard disk in the Secondary HDD bay for RAID level 5.

3. The Device Drivers & Utilities + User’s Manual disc.
4. For Recovery level RAID you will also require a USB Flash drive, external USB 

hard disk or external USB floppy disk drive and floppy diskette.
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SATA RAID or AHCI Setup Procedure (BIOS)
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode Selection" and press Enter (see 

page 5 - 8).

• Select either “RAID” or “AHCI”.

3. Press Esc and go to the Boot menu.
4. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is

inserted) as the first device in the boot order from the Boot menu.
5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and

press Enter to exit the BIOS and reboot the computer.
6. For RAID mode see the instructions in “RAID Setup (Intel Matrix)” on page 7 - 40.
7. For AHCI mode simply install the Intel Matrix driver after installing the OS and all

other drivers listed in Chapter 4 (see “Intel® Matrix Driver Installation” on
page 7 - 44).

RAID and Ready-
Drive Compatibility

On a system configured
in RAID mode, a condi-
tion exists where NV
Cache commands will
not be sent to the Win-
dows ReadyDrive*
cache provided by In-
tel® Turbo Memory. 

Microsoft has released a
Knowledge Base article
and QFE that addresses
this issue. (http://sup-
port.microsoft.com/
kb/954943).

Intel recommends that
customers who encoun-
ter this issue directly
contact Microsoft to ob-
tain the QFE.
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RAID Setup (Intel Matrix)
1. Press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next 

field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 or 

Recovery - see Table 7 - 1, on page 7 - 37) and then press Tab or Enter to 
advance to the next field.

5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select Create Volume.
9. Press Enter to create the volume, and confirm the selection by pressing Y.

RAID Volumes: * = Data is Encrypted

None Defined

Physical Disks:

Port Drive Model Serial # Size Type/Status(Vol ID)

0 FUJITSU MHY2120B K404T812P22B 111.7GB Non-RAID Disk

1 FUJITSU MHY2120B K404T7C2KJ14 111.7GB Non-RAID Disk

Intel(R) Matrix Storage Manager option ROM v8.5.0.1030 ICH10R wRAID5

Copyright (C) 2003-08 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[ ��] - Select [ESC]-Exit [ENTER]-Select Menu

1. Create RAID Volume 3. Reset Disks to Non-RAID

2. Delete RAID Volume 4. Recovery Volume Options

5. Exit

Figure 7 - 30
Intel(R) Matrix 

Storage Manager 
Option ROM

Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization between
the disks to be Continu-
ous (automatic) or On
Request (manually).
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10. This will now return to the main menu.

11. Select 5.Exit and press Enter, then press Y to exit the RAID configuration menu.
12. As the computer starts up, press a key when you see the message "Press any 

key to boot from CD".
13. Press Enter to continue installing the operating system as normal (see your 

Windows documentation if you need help on installing the Windows OS).
14. If you have selected a Recovery level RAID then see “Windows Installation for 

Recovery Level RAID Systems” on page 7 - 42.
15. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 

disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Matrix driver 
- see “Intel® Matrix Driver Installation” on page 7 - 44).

Figure 7 - 31
RAID Created

RAID Volumes: * = Data is Encrypted

ID Name Level Strip Size Status Bootable

0 MyRAID RAID1(Mirror) N/A 111.7GB Normal Yes

Physical Disks:

Port Drive Model Serial # Size Type/Status(Vol ID)

0 FUJITSU MHY2120B K404T812P22B 111.7GB Member Disk(0)

1 FUJITSU MHY2120B K404T7C2KJ14 111.7GB Member Disk(0)

Intel(R) Matrix Storage Manager option ROM v8.5.0.1030 ICH10R wRAID5

Copyright (C) 2003-08 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[ ��] - Select [ESC]-Exit [ENTER]-Select Menu

1. Create RAID Volume 3. Reset Disks to Non-RAID

2. Delete RAID Volume 4. Recovery Volume Options

5.Exit
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Windows Installation for Recovery Level RAID Systems
When you install Windows Vista for Recovery level RAID systems you will need to
provide the driver for the RAID system as per the instructions below. Firstly you will
need to go to an operable computer and copy the driver from the Device Drivers &
Utilities + User’s Manual disc to a USB Flash drive, external USB hard disk or ex-
ternal floppy disk drive and floppy diskette.

1. Go to the operable computer and insert a USB Flash drive, external USB hard disk 
or external USB floppy disk drive and floppy diskette.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive
of the operable computer.

3. Copy the RAID folder from the location below (D: denotes your DVD drive) on the
Device Drivers & Utilities + User’s Manual disc to the USB Flash drive, external
USB hard disk or floppy diskette.

• D:\Others\00RAID

4. Press a key at system startup to begin installing Windows from your Microsoft 
Windows Vista disc. 

5. Select your Language, Time and currency format and Keyboard or input method 
and click Next.

6. Click Install Now.
7. Enter your product key and click Next.
8. Make sure your USB Flash drive, external USB hard disk or external USB floppy 

disk drive and floppy diskette is attached to one of the USB ports on the computer.
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9. Select your Windows version (e.g. Windows Vista Ultimate) and click the “I have 
selected the edition of Windows that I purchased” tickbox and then click Next.

10. Click “I accept the license terms” tickbox and click Next.
11. Click Custom (advanced).
12. Click to select Load Driver when the “Where do you want to install Windows?” 

screen appears.
13. Click Browse and browse to the location you copied the files to on your USB Flash 

drive, external USB hard disk or external USB floppy disk drive and floppy diskette 
(X: denotes your USB Flash drive, external USB hard disk or external USB floppy 
disk drive):

• Vista 32bit - X:00RAID\f6flpy32\iaStor.inf
• Vista 64bit - X:00RAID\f6flpy64\iaStor.inf

14. Click Next (or format the master drive to your preferences).
15. Follow the on-screen instructions to install the Windows Vista operating system.
16. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 

disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Matrix driver 
- see “Intel® Matrix Driver Installation” on page 7 - 44).
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Intel® Matrix Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install TM&iMSM Driver > Yes.
4. Click Next > Next > Yes > Next.
5. Click Finish to restart the computer.

The Intel Matrix Storage Console displays status information on your RAID con-
figuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Stor-
age Manager in the Programs/All Programs menu. The Intel® Matrix Storage
Manager provides information on the RAID status.

e-SATA Port

Install the Intel Matrix
Storage driver to dis-
play the safe removal
icon for e-SATA devices
in the taskbar 

Figure 7 - 32
Intel Matrix Storage 

Console
(Basic & Advanced 

Views)
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Intel® Matrix Storage Manager 
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. The Help
menu (press F1 or select Contents and Index from the Help menu) provides in-
structions on how to recover or recreate RAID Volumes.

Figure 7 - 33
Intel Matrix Storage 

Manager Help
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0, RAID 1, RAID 5 or Recovery volume. The table outlines what
occurs for each RAID level:

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see “Intel Matrix
Storage Manager Help” on page 7 - 45.
See over for details on how to verify and repair RAID volume data.

RAID 
Level Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 1
Bad blocks are identified.
Data on the mirrored drive is compared to 
data on the source drive.

Bad blocks are reassigned.
If the data on the mirrored drive does not 
match the data on the source drive, the 
data on the mirrored drive is overwritten by 
the data on the source.

RAID 5
Bad blocks are identified.

Parity is recalculated and compared to the 
stored parity for that stripe.

Bad blocks are reassigned.

If the newly calculated parity does not 
match the stored parity, the stored parity is 
overwritten with the newly calculated parity.

Table 7 - 2
RAID Verification & 

Repair Status
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Verifying and Repairing RAID Volume Data
1. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Man-

ager in the Programs/All Programs menu.
2. Click View > Advanced Mode.
3. Right-click on the RAID volume and select either Verify Volume Data or Verify 

and Repair Volume Data.

4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair 

status.

Figure 7 - 34
RAID Verification 

(Intel® Matrix 
Storage Console)

Figure 7 - 35
Verification Status
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Intel Turbo Memory Module
If you have included an Intel Turbo Memory (Robson) NAND flash memory card
module in your purchase option, then you will need to enable AHCI or RAID mode
in the BIOS (see “Advanced Menu” on page 5 - 7) BEFORE installing the Win-
dows Vista operating system software (do not enable this option in Windows XP or
on a Windows Vista operating system that has been installed without the option en-
abled).

Note that if you are adding an Intel Turbo Memory (Robson) NAND flash memory
card module to a computer that already has an operating system and drivers etc. in-
stalled, you will need to reinstall the OS and all necessary drivers and utilities (make
sure you back up all your important data before doing so).

Intel Turbo Memory Technology (also known as Robson flash memory) is an Intel
technology that reduces the time it takes for a computer to boot up, to load applica-
tions, and to write data to the hard drive. Intel Turbo Memory Technology is sup-
ported in Windows Vista only (it also supports Windows Vista features such as
ReadyBoost, ReadyDrive, and Superfetch).

e-SATA Port 
Support

Note that the Intel Ma-
trix Storage driver is
required to support
the e-SATA port even if
you have not included
an Intel Turbo Memory
module in your pur-
chase configuration.

Follow the instructions
provided here in order to
install the driver.
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Intel Turbo Memory & Matrix Storage Setup and Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install TM&iMSM Driver > Yes.
4. Click Next > Yes > Next > Next.
5. Click Finish to restart the computer.
6. For Turbo Memory modules that support User Pinning see “Intel Turbo 

Memory Dashboard (User Pinning Supported Only)” on page 7 - 50.
7. For Turbo Memory modules that do not support User Pinning see“Intel 

Turbo Memory Console (All Modules)” on page 7 - 53.

If the Turbo Memory module supports User Pinning then the Intel Turbo Memory
Dashboard will be installed. If the Turbo Memory module does not support User
Pinning then the Intel Turbo Memory Dashboard will not be installed.

ReadyBoost Issue

When the Intel® Turbo
Memory Console is
opened immediately after
powering on the system,
Windows ReadyBoost
may appear to be disabled.

This is expected behavior.
The status appears as dis-
abled while Microsoft gen-
erates the Windows
ReadyBoost file. Once the
file has been generated,
the status should appear as
Enabled again.

See the Intel website (ht-
tp://support.intel.com/
support/chipsets/itm/sb/
CS-025852.htm) for the
latest updated information
on this issue.
Intel Turbo Memory Module 7 - 49

http://support.intel.com/support/chipsets/itm/sb/CS-025852.htm
http://support.intel.com/support/chipsets/itm/sb/CS-025852.htm
http://support.intel.com/support/chipsets/itm/sb/CS-025852.htm


Modules

7

Intel Turbo Memory Dashboard (User Pinning Supported Only)
The Intel Turbo Memory Dashboard allows you to pin an application or file to
load into the Intel Turbo Memory NAND cache for performance acceleration.

1. Run the Intel® Turbo Memory Dashboard from the Programs/All Programs 
menu (Intel® Turbo Memory) or from the desktop shortcut.

2. The Pinning Capacity Consumption Meter  displays the amount of pinning 
space used.

3. The Control and Profile Pull-Down Menu  allows you to select and manage 
profiles. 

4. The Application Window  lists all applications available for performance 
acceleration. When accelerated the applications/files will appear in the 
Accelerated Window .

5. The Custom Sets Window  allows you to select specific files to be pinned. 

Help

Click the Help icon  to
bring up the menu and
click to select and help
topic.

Figure 7 - 36
Intel Turbo Memory 

Dashboard

1

2

3

4
5

1
2

3

4
5
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Pinning an Application (User Pinning Supported Only)
1. The Intel® Turbo Memory Dashboard allows you to select files and 

applications to accelerate and therefore open faster and display quicker.
2. Applications will be listed in the Applications Window on the right.
3. To accelerate any application drag the icon into the Accelerated pane on 

the left (the available memory is indicated in the top left).
4. A status bar indicates the pinning progress and will turn green when ready.

Unpinning an 
Application

Click the application in
the Accelerated Win-
dow and drag it back to
the Applications Win-
dow to unpin the appli-
cation.

You can also unpin the
application by right-
clicking it in the Appli-
cations Window and
selecting “Remove
from Cache.”

Figure 7 - 37
Accelerated 
Applications
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Custom File Sets (User Pinning Supported Only)
A Custom File Set allows you to group applications and files to accelerate. These
sets can be moved easily in and out of the Accelerated Window which is of benefit
when space is limited. You need to create the custom file set before dragging the set
to the accelerated window.

1. Click Custom File Sets and type a name for the set, and then click Next.
2. Select the file set folder icon and click Advanced. 
3. Click the Browse button and select the files and applications to accelerate.
4. Click the Done button when finished.
5. Drag the custom set across to the Accelerated Window from Custom File 

Sets to accelerate.

Figure 7 - 38
Create Custom File 

Set
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Intel Turbo Memory Console (All Modules)
1. Run the Intel® Turbo Memory Console from the Programs/All Pro-

grams menu (Intel® Turbo Memory).
2. You can enable/disable Windows ReadyBoost and Windows ReadyDrive 

from the Intel® Turbo Memory Console.

• Windows ReadyBoost - uses flash memory as a hard-drive caching solution 
(Not supported if User Pinning is supported).

• Windows ReadyDrive - uses hybrid drives as a hard-drive caching solution.

Windows 
ReadyBoost

If your module supports
User Pinning (i.e. the
Intel Turbo Memory
Dashboard is installed)
then ReadyBoost is
not supported (the item
will be grayed out).

Note that the Intel Turbo
Memory Console DOES
NOT appear if you have
not included a Turbo
Memory module in your
purchase configuration.

Figure 7 - 39
Intel Turbo Memory 

Console

RAID and ReadyDrive 
Compatibility

On a system configured in RAID mode, a
condition exists where NV Cache commands
will not be sent to the Windows Ready-
Drive* cache provided by Intel® Turbo
Memory. 

Microsoft has released a Knowledge Base
article and QFE that addresses this issue.
(http://support.microsoft.com/kb/954943).

Intel recommends that customers who en-
counter this issue directly contact Microsoft
to obtain the QFE.
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 8) 
to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 4, on page 1 - 11).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a DVD 
wallet.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 10).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief 
notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.
Upgrading and Adding New Hardware/Software 8 - 5
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices 
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems & Possible Solutions

Problem Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present
and seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard/USB device/
external device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn off/remove the
unused device to save power.
Problems & Possible Solutions 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing appears on
screen.

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).
\

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key
combinations. If you’re connected to an external monitor, make sure it’s plugged in and turned
on. You should also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.

Problem Possible Cause - Solution
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You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2
- 11) to adjust.

The compact disc
cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems & Possible Solutions 8 - 9
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The TouchPad doesn’t
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

I am sliding my finger up
and down on the right
side of the TouchPad to
scroll a Window and the
TouchPad does not
respond.

There are different TouchPad versions available on this computer, and this version requires
tapping/holding to scroll. Either tap repeatedly, or hold the finger down, at the top or bottom right
of the touchpad (depending on the scrolling direction required) to scroll the window.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “Power-Saving States” on page 3 - 6/“System Power Options”
on page D - 18). Make sure you have enabled Hibernate mode from the control panel.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
detected.

The modules are off. Check the appropriate LED indicator  for the WLAN or Bluetooth
module to see if the modules are on or off (see “LED Indicators” on page 1 - 8). If the LED
indicator is off, then press the appropriate function key combination in order to enable the
modules (see Table 1 - 4, on page 1 - 11). 

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
module).

Problem Possible Cause - Solution
8 - 10 Problems & Possible Solutions



Troubleshooting

8

The PC Camera
software displays a
black screen when the
PC Camera application is
run.

The software is using the incorrect device. If you have both an optional PC Camera and an optional
TV Tuner module present, you will need to select which device to use with the PC Camera appli-
cation. Go to the Devices menu in the PC Camera application and select the USB Video Device
device.

Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
needs to be run while the default notebook LCD is the selected display device. 
After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).
If you have selected an external display as your display device do not run the PC Camera
application until you have switched back to the notebook LCD.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

No sound can be heard
through an HDMI
connected display
device.

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page B -
14.

Problem Possible Cause - Solution
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When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

The Hibernate function
has disappeared.

You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This
is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack
1. To re-enable Hibernate mode go to the Command Prompt and type the command “powercfg
-h on” (make sure you are logged on as an Administrator):

1. Click Start  (menu button).
2. Type “cmd” in the Start Search box .
3. Double click the Command Prompt  when it appears in the menu.
4. Type “powercfg -h on” in the Command Prompt window.
5. Close the Command Prompt window.
6. The Hibernate function will now be enabled.

The audio recording
quality is poor.

The audio recording settings have not been set to the optimal quality. Go to the Realtek HD
Audio Manager  and select Noise Suppression in Microphone (Microphone Effects). See
“Setup for Audio Recording” on page 2 - 12 for more details.

Problem Possible Cause - Solution
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The on screen volume
indicator
does not display the
volume adjustment when
using an HDMI
connected display
device.

When adjusting the volume for an HDMI connected display device the on screen volume indicator
 will not display the volume level as it is being adjusted. If you do need to see the

volume level as it is being adjusted you can display the Windows volume level indicator or the
Realtek HD Audio Manager (Digital Output) volume indicator.

The Wireless LAN
indicators 
show that the WLAN
module is powered on,
however the module
does not connect.

The WLAN module is turned off in the Windows Mobility Center. The computer’s wireless
function keys will not function properly if Wireless is turned OFF in the Windows Mobility
Center control panel. Make sure that Wireless is ON in the Mobility Center to ensure proper
function key behavior (see “Wireless Hot Keys” on page 3 - 11).

There is a background
noise when playing a
DVD in Windows Media
Player through an HDMI
connection to an LCD
monitor/TV.

The LCD monitor/TV does not have a built-in digital audio decoder. Disable DTS Audio and
Dolby Digital as supported formats from the Sound control panel > Realtek Digital Output >
Supported Formats (tab). See “Audio Setup for LCD Monitors/TVs with HDMI Input” on
page  B - 15 for details.

Problem Possible Cause - Solution
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Screen Resolution Error
If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with
Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is
closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is
opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen
resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and 
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

Figure 8 - 1 - Control Panel System and Maintenance
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3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

Figure 8 - 2 - TMM Disable
6. Close all the control panels.
Screen Resolution Error 8 - 15



Troubleshooting

8

Bluetooth Connection Problems
If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver. 

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and 

Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have 

connected, or tried to connect to, a Bluetooth device previously).

Figure 8 - 3 - Device Manager

Bluetooth Peripheral Devices
You will need to repeat the procedure
listed here for all Bluetooth Peripher-
al Devices listed under Other Devices
i.e. until there are no more Bluetooth
Peripheral Devices listed under this
menu heading.
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 4 - Browse my computer.../Let me pick from...
9. Select Bluetooth Radios from the list.

Figure 8 - 5 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other. 
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not 

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for 
Microsoft Corporation to appear in the list). 

12. Select Windows Mobile-based device support from the Model list.

Figure 8 - 6 - Select Device Driver
13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Make sure you select
Microsoft Corporation
8 - 18 Bluetooth Connection Problems
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth 
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 7 - Device Manager - Bluetooth Radio
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Ports and Jacks
Item Description

Card Reader The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)
MS (Memory Stick Pro)

Cable (CATV) 
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional TV Tuner in your
purchase.

Consumer Infrared 
Transceiver

The consumer infrared transceiver at the front of the computer allows the computer to
communicate with the remote control unit supplied with the optional TV Tuner.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port (at the rear of the computer) allows you to connect an
external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD
and external monitor/FPD (see “Display Devices” on page B - 5). If you are using an older type
of monitor you will need to use a converter to convert the signal from DVI to VGA.

e-SATA Port Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port. Install the Intel Matrix Storage driver to display the safe removal icon for e-
SATA devices in the taskbar (see “Intel® Matrix Driver Installation” on page 7 - 44).e-SATA
A - 2 Interface (Ports & Jacks)
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HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device (see “” on page B - 6) by means of a HDMI cable.
Note that HDMI carries both audio and video signals (see “HDMI Audio Configuration” on
page B - 14).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound  control panel and make sure the Mute box is not
ticked.

Item Description

HDMI

HDMI Audio Support

Note that some NVIDIA video card models DO NOT support High Definition Audio through
HDMI. When connecting these video cards to an external display (using an HDMI cable), it
is recommended that you use a third party video application (e.g. Power DVD) that provides
appropriate audio decoding to play DVDs etc. Alternatively you can output audio through an
alternative source to the HDMI connection.
Interface (Ports & Jacks) A - 3
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Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

RJ-11 Phone Jack This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Item Description

IEEE 1394
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure you
install the IEEE 1394 filter driver (see page 4 - 6).
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Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
Interface (Ports & Jacks) A - 5



Interface (Ports & Jacks)

A

A - 6



NVIDIA Video Driver Controls

B

Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 17.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next (or Next > Next).
3. Click Finish to restart the computer.

Driver Versions

Note that there are two driv-
er versions supplied with
this video card. Your sys-
tem will have the most suit-
able driver installed. The
control panels for each
driver may appear slightly
differently from each other,
and both versions are illus-
trated here.

Video Card Options

Note that card types, spec-
ifications and drivers are
subject to continual up-
dates and changes. Check
with your service center for
the latest details on video
cards supported.

Screen Flickering

Note that the display may briefly flicker during display device detection (switching dis-
plays etc.), or if changes in resolution or mode settings are taking place (this includes
resuming from power saving modes, opening and closing the lid and logging on to Win-
dows etc.). 
NVIDIA Video Driver Installation B - 1
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Open the Display Settings (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).

NVIDIA Control 
Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure B - 1
NVIDIA GeForce..... 

Control Panel
B - 2 NVIDIA Control Panel



NVIDIA Video Driver Controls

B

The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc. Navigating the 

Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control 

Panels
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B - 3
Help Menus
B - 4 NVIDIA Control Panel
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Display Devices
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to
connect an external display (if you are using an older type of monitor you can use a
converter to convert the signal from DVI to VGA). See your display device manual
to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the

HDMI-Out Port.

Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The fol-
lowing are the display
options:

• The built-in LCD.
• An external display 

connected to the DVI-
Out port.

• An external display 
connected to the 
HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aeri-
al to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.
Display Devices B - 5
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Display Modes
Single Display Mode
Only one of your displays is used.

Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Dualview Mode/Extended Mode
Dualview/Extended Mode treats both connected displays as separate devices, and
they act as a virtual desktop resulting in a large workspace. When Dualview/Extend-
ed Mode is enabled, you can drag any icons or windows across to the other display
desktop. It is therefore possible to have one program visible in one of the displays,
and a different program visible in the other display.
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Attaching Other Displays
Configuring an External Display in Windows Vista
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure B - 4
New Display 

Detected
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Configuring an External Display using the NVIDIA Control Panel (Ver 1)
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display, and then click Set up multiple displays.

4. Click to select the nView display mode you wish to use (see page B - 15).
5. Select the display(s) you want to use (if your display is not shown click “My Display

is not shown in the list...”), and choose which display is to be the primary display.
6. Click Apply > Yes to save the changes.

Figure B - 5
Set Up Multiple 

Displays
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Configuring an External Display using the NVIDIA Control Panel (Ver 2)
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”

Figure B - 6
Set Up Multiple 

Displays
Attaching Other Displays B - 9



NVIDIA Video Driver Controls

B

5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save the changes.
7. The default display mode will be in Extended mode (i.e the desktop will be

extended on to the external display - see “Display Devices” on page B - 5), and
you can use the built-in NVIDIA controls (“Enabling Clone Mode (Ver 2)” on
page B - 11) or New Display Detected (“” on page B - 6) window to configure the
display.

8. If you prefer to use Clone mode see overleaf.

Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown...” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure B - 7
Select Display to 

Use
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Enabling Clone Mode (Ver 2)
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page  B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save the changes.
7. The default display mode will be in Extended mode, to change to Clone Mode

right-click one of the display icons and click “Clone Laptop Display and....” (a tick
will appear alongside it) option from the pop-up menu and click Apply.

Figure B - 8
Enable Clone Mode
Attaching Other Displays B - 11
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8. To switch back to Extended Mode right-click one of the display icons and click
“Clone Laptop Display and....” (to remove the tick) option from the pop-up menu
and click Apply.

Figure B - 9
Switch to Extended 

Mode
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NVIDIA Video Driver Controls

B

Using New Display Detected to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

Figure B - 10
New Display 

Detected 
(Extended)
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Click Start, and click Control Panel (or point to Settings and click Control

Panel).
3. Click Adjust screen resolution under the Appearance and Personalization

menu (or double-click Personalization > Display Settings).
4. Click the monitor icon (e.g. ), and make sure you have checked “Extend the

desktop onto this monitor.” and click Apply.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 11
Display Settings 

(Extend the 
Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you will need to configure the audio output as per the instructions below.

Windows Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound  control panel.
6. You will now be able to hear audio sources when played in Windows Media Player

if supported (see “HDMI Audio Support” on page B - 16).
Figure B - 12
Realtek Digital 

OutputClick the taskbar volume in-
dicator  when Realtek
Digital Output is selected,
and you will note that the
icon at the top of the volume
level indicator has changed.
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.

• If you disconnect the HDMI cable the default audio playback device will not 
revert to speakers until the computer is restarted (if you do not wish to restart the 
computer then go to the Sound control panel and select Speakers as the default 
audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an

External Display using the NVIDIA Control Panel (Ver 2)” on page B - 9.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.

 Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).

HDMI Audio Support

Note that some NVIDIA video card models DO NOT support High Definition Audio through
HDMI. When connecting these video cards to an external display (using an HDMI cable), it
is recommended that you use a third party video application (e.g. Power DVD) that provides
appropriate audio decoding to play DVDs etc. Alternatively you can output audio through
an alternative source to the HDMI connection.
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Enabling TV Display (Ver 1)
To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if sup-
ported by your TV).

You will need to enable the TV display from the NVIDIA Control Panel as per the
instructions on B - 9. The TV will appear as a display option (2. Select the displays
you would like to use.) when attached to the appropriate port. Apply the settings,
and then click Yes to save the changes.

Detect Displays

To get a full range of dis-
play options click “My dis-
play is not shown in the
list...”.

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page B -
15 for instructions on
configuring audio for
HDMI display devices. 

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

Figure B - 13
Set Up Multiple 

Displays 
(with TV connected) 
Enabling TV Display (Ver 1) B - 17
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Changing the TV Signal Format (Dualview Mode Only)
1. When the TV is enabled as a display device, and Dualview is the selected display 

mode, click the sub-menus under Video & Television.
2. Click “Change the signal or HD format”
3. Select the TV signal format (the menu allows you to select TV format by country if

you are unsure of your TV format).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 14
Change the Signal or 

HD Format
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Enabling TV Display (Ver 2)
To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if sup-
ported by your TV).

1. You will need to enable the TV display from the NVIDIA Control Panel as per the 
instructions on page B - 9. The TV will appear as a display option (“1.Select the 
displays you want to use.”) when attached to the appropriate port. 

2. Apply the settings, and then click Yes to save the changes.
3. The settings for TV and Video may be adjusted using the sub-menus under Video

& Television.

Detect Displays

To get a full range of dis-
play options click “My
Display is not
shown...”
HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page B -
15 for instructions on
configuring audio for
HDMI display devices. 

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

Figure B - 15
Video & Television
Enabling TV Display (Ver 2) B - 19
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Changing the TV Signal or HD Format
1. When the TV is enabled as a display device click the sub-menus under Video & 

Television.
2. Click “Select the format you would like to use.”.
3. Select the TV signal format you would like to use.
4. Apply the settings, and then click Yes to save the changes.

Figure B - 16
Change the Signal or 

HD Format
B - 20 Enabling TV Display (Ver 2)
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
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Processor

Intel® Core® i7 Processor:

i7-965 (3.20 GHz, 8M L3 Cache, 45nm, 
6.4 GT/s on QPI, LGA1366 Package - 
TDP 130W)

i7-950 (3.06 GHz, 8M L3 Cache, 45nm, 
4.8 GT/s on QPI, LGA1366 Package - 
TDP 130W)

i7-940 (2.93 GHz, 8M L3 Cache, 45nm, 
4.8 GT/s on QPI, LGA1366 Package - 
TDP 130W)

i7-930 (2.80 GHz, 8M L3 Cache, 45nm, 
4.8 GT/s on QPI, LGA1366 Package - 
TDP 130W)

i7-920 (2.66 GHz, 8M L3 Cache, 45nm, 
4.8 GT/s on QPI, LGA1366 Package - 
TDP 130W)

Core Logic

Intel® X58 + ICH10R

Display

17.1” (43.43cm) WUXGA (1920 * 1200) 
TFT LCD

Memory

Triple 64-bit wide DDRIII (DDR3) data 
channels 
Three 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1066/
1333MHz Memory Modules
Memory Expandable up to 12GB
Note: Use either 1066MHz OR 1333MHz 
DDRIII (DDR3) Modules - Do not mix 
DRAM speeds

Turbo Memory

Intel® Turbo Memory 4GB Mini-Card 
(Factory Option)

Video Adapter

nVIDIA® GeForce GTX 280M PCIe *16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10.0
Supports HDCP

Video Adapter (cont’d)

nVIDIA® GeForce GTX 285M PCIe *16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10.0
Supports HDCP

nVIDIA Quadro QDFX3800M PCIe *16 
Video Card
1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10.1
Supports HDCP
Supports DVI Dual-link
Supports OpenGL 3.1

nVIDIA GeForce GTX480M PCIe *16 
Video Card
2GB GDDR5 Video RAM on board 
Supports Microsoft DirectX® 11
Supports HDCP
Supports DVI Dual-link
Supports HDMI 1.4
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BIOS

One 16Mbit Flash ROM
Phoenix™ BIOS

Storage

Up to three (Factory Option) 
Changeable 2.5" 9.5 mm (h) SATA 
(Serial) Hard Disk Drives supporting 
RAID level 0/1/5 and Recovery
One 12.7 mm Super Multi/Blu-Ray SATA 
Optical Device Drive (Factory Option)

Pointing Device

Built-in TouchPad (scrolling key 
functionality integrated)

Keyboard

“WinKey” keyboard (with embedded 
numeric keypad)
Three Instant Keys (WWW, e-mail, 
Application)

Audio

High Definition Audio Compliant Interface
Compliant with Microsoft UAA (Universal 
Audio Architecture)
S/PDIF Digital Output
Supports 5.1 Channel Analog Outputs
4 * Built-In Speakers
Built-In Microphone

Slots

One ExpressCard/34/54 Slot
Three Mini Card Slots:
• Slot 1 for PCIe WLAN Module
• Slot 2 for USB TV Tuner Module
• Slot 3 for Intel® Turbo Memory Module

Card Reader

Embedded 7-in-1 Card Reader (MS/ MS 
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS 
Duo) Note: MS Duo/ Mini SD/ RS MMC 
Cards require a PC adapter

Communication

10Mb/100Mb/1000Mb Base-T Ethernet LAN
56K MDC Modem, V.90 & V.92 Compliant 
(Factory Option)
3rd Party 802.11b/g Wireless LAN Mini-
Card Module (Factory Option)
Intel® WiFi Link 5300 Series (3*3 - 
802.11a/g/n) Wireless LAN Mini-Card 
Module (Factory Option)
Intel® WiFi Link 5100 Series (1*2 - 
802.11a/g/n) Wireless LAN Mini-Card 
Module (Factory Option)
3.0M Pixel USB PC Camera Module 
(Factory Option)
Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)
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Interface

Four USB 2.0 Ports
One HDMI (High-Definition Multimedia 
Interface) Port with Audio Output (with 
HDCP Support)
One DVI-Out Port (no HDCP Support)
One eSATA Port (hot swapping 
supported in Windows Vista/Win 7 only)
One S/PDIF Out Jack
One Headphone-Out Jack
One Microphone-In Jack
One Mini-IEEE1394a Port
One Line-In Jack for Audio Input
One RJ-45 LAN Jack
One RJ-11 Modem Jack
One DC-in Jack
One Cable (CATV) Antenna (Analog/
Digital) Jack (Functions with Factory 
Optional USB TV Tuner Module)
One Consumer Infrared Transceiver
(Functions with Factory Optional USB 
TV Tuner Module)

Security

Kensington Lock
BIOS Password

Operating System

Windows® Vista (with Service Pack 2) 
Home Premium/ Business/ Enterprise/ 
Ultimate

Note that the TV Tuner module (factory) option 
in Windows Vista is supported by the 
Windows Media Center software which 
comes built-in to the Windows Vista Home 
Premium and Ultimate Editions only. 

Windows® 7

Note that the TV Tuner module (factory) option 
in Windows 7 is supported by the Windows 
Media Center software which comes built-in to 
the Windows 7 Home Premium, 
Professional and Ultimate Editions only. 

Power

Full Range AC/DC Adapter
AC Input: 100 - 240V, 50 - 60Hz
DC Output: 20V, 11A or 19V, 11.6A (220 
Watts)

Power Management

Supports Wake on USB
Supports Resume from Modem Ring

Battery

12 Cell Smart Lithium-Ion Battery Pack, 
97.68WH (6600 mAH)

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

397mm (w) * 298mm (d) * 51 - 60mm (h)
5.4 kg
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Factory Options

One 12.7 mm Super Multi/Blu-Ray SATA 
Optical Device Drive

PCIe or USB Mini-Card Wireless LAN 
Module 
(see “Communication” on page C - 3)

USB Mini-Card Hybrid TV Tuner Module

USB Bluetooth 2.1 + EDR Module 
(see “Communication” on page C - 3)

USB PC Camera Module 
(see “Communication” on page C - 3)

Intel® Turbo Memory 4GB Mini-Card 
Specifications C - 5
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Appendix D: Windows 7 Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 7 OS where there are significant differences from Windows Vista, or where is it helpful to have
essential information or features repeated. For items not specifically covered here see the remainder of the man-
ual for information.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS (see “Setting
Up SATA RAID or AHCI Modes (Win 7)” on page D - 59).
D - 1
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DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table D - 1 - DVD Region Codes

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (System and Security > System), then click the + next to DVD/CD-ROM
drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
D - 2 DVD Regional Codes
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure D - 1 - Start Menu & Control Panel

Click here to toggle Category View
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Hot Key Buttons & Game Keys
These buttons give instant access to the default Inter-
net browser and e-mail program, and to a user-defined
application, with one quick button press. To use the
“user-defined application Hot Key Button”, you must
install the driver. See “Application Hot Key” on
page 2 - 8 for configuration instructions.
 

Table D - 2- Hot Key Buttons

The two Game Keys on the left of the computer allow
macros to be configured for common keystrokes used
in applications, as long as the driver is installed (see
“GameKey Utility” on page D - 31/“Game Keys” on
page 2 - 9).

Figure D - 2 - Game Key Configuration

Hot Key Function

Activate the Default E-Mail Browser (Note 
that In Windows 7 without Outlook/Outlook 

Express installed this button has no function. If 
Outlook/Outlook Express are installed then the 

button will activate the application)

 Activate the Default Internet Program

Activate the user specified application e.g. 
Microsoft Word or Excel
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators (see the table below) are available when the hot key
utility is installed (see “HotKey Utility” on page D - 31). After installing the driver an icon  will appear in the
taskbar.

Table D - 3 - Function/Hot Key Combo Indicators

Fn Keys Function Fn Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F5/
F6

Volume Decrease/
Increase

Fn + 1 Fan Automatic Control / Full Power Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/
F9

Brightness Decrease/
Increase

Fn + F2 Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on) Fn + F10 PC Camera Power 

Toggle

Fn + F3 Mute Toggle Fn + F11 WLAN Module Power 
Toggle

Fn + F4  Sleep Toggle Fn + F12 Bluetooth Module Power 
Toggle
Function/Hot Key Indicators D - 5
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Video Features
You can configure display options, from the Display Settings control panel in Windows as long as the appro-
priate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on
page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution (see right).
5. Use the dropbox to select the screen Resolution  (Figure D - 3 on page D - 7).
6. Click Advanced settings  (Figure D - 3 on page D - 7) to bring up the Advanced properties tabs.

To access the NVIDIA Control Panel:
1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel  (Figure D - 4 on page D - 8) - In the Appearances and Personalization

category.
OR
3. Click Start and click All Programs > NVIDIA Corporation.
4. Click to select NVIDIA Physx Properties  (Figure D - 4 on page D - 8) .
OR
5. Click Advanced settings in the Screen Resolution control panel in Windows.
6. Click GeForce....(tab) and click Start the NVIDIA Control Panel  (Figure D - 4 on page D - 8).

1
2

3

4

5
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Screen Resolution
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as
your display device.

Figure D - 3 - Screen Resolution

1

2

Video Options

Note that card types, specifications
and drivers are subject to continual
updates and changes. Check with
your service center for the latest de-
tails on video cards supported.
Video Features D - 7
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NVIDIA Control Panel
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as
your display device.

Figure D - 4 - NVIDIA Control Panel

3
4

5
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Attaching Other Displays
Configuring an External Display in Windows 7
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure D - 5 - Screen Resolution - Multiple Displays
Video Features D - 9
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5. You can configure the displays from the Multiple Displays menu.

Figure D - 6 - Screen Resolution - Multiple Display Options
• Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

See “Attaching Other Displays” on page B - 6 for more details on the above modes when using the NVIDIA
driver to configure attached displays.
D - 10 Video Features
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Configuring an External Display using the NVIDIA Control Panel
Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page D - 6).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”

5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save any changes made.

Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown...” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure D - 7
Set Up Multiple 

Displays
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Enabling Clone or Dualview Modes
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page D - 6).
3. Double-click Display (if the sub-menus are not visible), and then click Set up multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Right-click one of the display icons and click “Clone....” (a tick will appear alongside it) to Clone the display or

click to remove the tick to use Dualview mode,
7. Click Apply > Yes to save the changes.

Figure D - 8 - Enabling Clone/Extended Modes
D - 12 Video Features
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage
the computer and its components.

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Move the left LCD latch towards the unlock position, and move the right latch outwards towards the sides of the

computer, and hold it in position, to release the top cover.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 120 degrees); use

the other hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Press the power button to turn the computer on.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable.
Battery life varies depending on the applications and the configuration you're using. To increase battery life,
let the battery discharge completely before recharging (see “How do I completely discharge the battery?”
on page D - 25). We recommend that you do not remove the battery. For more information on the battery, please
refer to “Battery Information” on page D - 21.
The Power Sources D - 13



Windows 7 Information

D

Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page D
- 19 for details).

Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the Lock Button Menu in Windows 7. This will help prevent hard disk or system
problems.
D - 14 Turning On the Computer
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

See Table D - 4, on
page D - 20 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure D - 9
Power Plan 

Advanced Settings
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure D - 10
Power Plans

Click to Show/Hide 
additional 
power plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where you left off. Sleep is the
default power-saving state in Windows 7.

Earlier versions of Windows used Stand By and Hibernate as system power-saving states. Windows 7 combines
the features of Stand By and Hibernate into the default Sleep power-saving state.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are
not using your computer for a certain length of time, which you specify in the operating system, it will enter
Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desk-
top) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power.
After an extended period the system will save all the information to the hard disk and shut the computer down
before the battery becomes depleted.
Power-Saving States D - 17
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan to
be away from the computer for several days, or you do not need it to wake up and run
a scheduled task. Returning to full operation from Shut down takes longer than from
Sleep or Hibernate.

Figure D - 11
Lock Button Menu
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-
saving state. Click Choose what the power buttons do on the left menu in Power Options to bring up the menu.

Password Protection

It is recommended that you
enable a password on wake
up in order to protect your
data.

However you can disable
this setting from the Power
Options menu by clicking
Require a password on
wakeup in the left menu,
and selecting the options
(click Change settings that
are currently unavailable).

Figure D - 12
Power Options Define 

Power Buttons
Configuring the Power Buttons D - 19
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Resuming Operation
You can resume operation from power-saving states by pressing the power button, or in some cases pressing the
sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table D - 4
Resuming 
Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
D - 9 on page D - 15).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure D - 13
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
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Windows 7 Information

D

Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.
• Lower the brightness level of the LCD display. The system will decrease LCD 

brightness slightly to save power when it is not powered by the AC/DC adapter.
• Reduce the amount of time before the display is turned off.
• Close wireless, Bluetooth, modem or communication applications when they are 

not being used.
• Disconnect/remove any unnecessary external devices e.g. USB devices, 

ExpressCards etc.

Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure D - 14
Windows Mobility 

Center
Make sure Wireless is ON to ensure proper function key behavior.
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason
(e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 25 for instruc-
tions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page D - 21
for more information on how to maintain and properly recharge the battery pack.)
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even
if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut
down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after creating it) and click Change plan settings > Change advanced power 

settings.

Figure D - 15 - Create Power Plan - Discharge Battery
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

Figure D - 16 - Power Options Advanced Settings - Battery
• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Battery Charging & 
Maintenance

How do I fully charge the battery?
When charging the battery, don’t stop
until the LED charging indicator light
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the
battery at least once every 30 days or
after about 20 partial discharges.
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc, click Install Drivers/Option Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu. Follow the instructions to install the
driver. Alternatively click Start, navigate (Browse..) to
the executable file and then follow the manual setup in-
structions.

Figure 5 - Drivers Installer Screen 1

1. Check the driver installation order from Table D - 5 (the 
drivers must be installed in this order) which is the 
same as that listed in the Drivers Installer menu 
below.

2. Click to select the driver you wish to install, after 
installing each driver it will become greyed out (if you 
need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following pages.

Figure 6 - Drivers Installer Screen 2
Driver Installation D - 27
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 Table D - 5 - Driver Installation

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Programs and Features item (Programs >
Uninstall a program). If you see the individual driver
listed (if not see below), uninstall it, following the on
screen prompts (it may be necessary to restart the com-
puter). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the driver in
question.

If the driver is not listed in the Programs and Features
item:
1. Click Start and click Control Panel. 
2. Double-click System (icon); System (icon) is in 

System and Security (category).
3. Click Device Manager (in the left menu).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Driver for Windows 7 Page

Chipset Page D - 29

Video Page D - 29

LAN Page D - 29

Modem Page D - 30

Audio Page D - 30

TouchPad Page D - 30

Card Reader/ExpressCard Page D - 30

IEEE 1394 Filter Page D - 30

GameKey Utility Page D - 31

HotKey Utility Page D - 31

Wireless LAN Module (Win 7) Page D - 39

PC Camera Module (Win 7) Page D - 45

Consumer Infrared Driver Installation (for TV Tuner 
remote) Page D - 51

Intel® Matrix Driver Installation (Install to support 
RAID or AHCI, Intel Turbo Memory and e-SATA port) Page D - 67
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

RAID Note: Setting up a RAID, or AHCI mode,
needs to be done prior to installing the Windows OS,
and therefore before installing the other drivers listed
here.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish (or Finish to restart the computer 

in AHCI mode) to complete the installation (in 
RAID mode).

Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes. 
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.
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Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is now ready for configuration.

Audio
1. Click 5.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license and click 

Next.
4. Click Finish > Restart Now to restart the com-

puter.
5. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 10.

Card Reader/ExpressCard
1. Click 7.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

IEEE 1394 Filter
1. Click 8.Install 1394 Filter Driver > Yes.
2. Click Install > Finish.

Modem Country Selection

Go to the Phone and Modem control panel and make
sure the modem country selection is appropriate for you.
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GameKey Utility
1. Click 9.Install GameKey Utility > Yes.
2. Click Next.
3. Click Finish to restart the computer.
4. See “Game Keys” on page 2 - 9 for configura-

tion instructions.

HotKey Utility
1. Click 10.Install HotKey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
4. See “Application Hot Key” on page 2 - 8 for 

configuration instructions.

Make sure you install the Intel Matrix Storage Man-
ager driver to fully support hard disks in AHCI or
RAID modes (see “Intel® Matrix Driver Installa-
tion” on page 7 - 44). Also install this driver to display
the safe removal icon for e-SATA devices in the task-
bar for the e-SATA port. This driver is also required if
you have included an Intel Turbo Memory module in
your purchase configuration.

Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion. Where Windows 7 information differs from
Windows Vista it will be included in this chapter; if
Windows 7 information is the same as Windows Vista
then refer to Chapter 7 as indicated below and on the
following page. 

Figure D - 1 - Drivers Installer - Option Drivers Menu
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Bluetooth Module (Win 7)
Note: The operating system is the default setting for
Bluetooth control in Windows 7, and does not require
a driver. See “Bluetooth Module (Win 7)” on page D
- 33 for configuration instructions.

Wireless LAN Module (Win 7)
See the specific Windows 7 driver installation and
configuration information in “Wireless LAN Module
(Win 7)” on page D - 38.

PC Camera Module
See “PC Camera Module (Win 7)” on page D - 44 for
driver installation and configuration information.

Consumer Infrared Driver
To install the consumer infrared driver for the TV Tun-
er see “TV Tuner Module (Win 7)” on page D - 50 for
driver installation and configuration information.

Intel Turbo Memory Driver
See “Intel Turbo Memory Module (Win 7)” on
page D - 53 for driver installation and configuration
information.

RAID Setup
Note: See “Setting Up SATA RAID or AHCI Modes
(Win 7)” on page D - 59 for configuration instruc-
tions.
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Bluetooth Module (Win 7)
The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

Use the Fn + F12 key combination (see Table D - 3, on page D - 5) to toggle power
to the Bluetooth module (when the Bluetooth module is on, the  LED will be
orange). The operating system’s Bluetooth Devices control panel is used to config-
ure the Bluetooth settings in Windows 7, and therefore does not require a driver.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED to see if the
module is powered on or
not (see Table D - 3, on
page D - 5/ Table 1 - 2, on
page 1 - 8).

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use
the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from
Sleep.
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the taskbar icon  to access the Bluetooth Devices control panel.
• Click/Right-click the taskbar icon  and choose an option from the menu.

Add a Device

Click Start, and click
Control Panel and then
click Devices and
Printers (Hardware
and Sound). Click Add
a device to search for
any available Bluetooth
devices.

Figure D - 2
Bluetooth Devices & 

Click Icon Menu

Add a device

Right-Click Taskbar Icon 
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered
onto the device.

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure D - 3
Add a Device
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.

Figure D - 4
Pairing Code 

Example

Figure D - 5
Pairing Complete & 
Bluetooth Device 

Enabled

Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:
• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this

computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect

check box (Connections) has a tick inside it, if you want to be notified when a
Bluetooth device wants to connect.

Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure D - 6
Bluetooth Settings - 

Options
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Wireless LAN Module (Win 7)
If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) or 3rd
Party 802.11b/g WLAN module in your purchase option, make sure that the Wireless
LAN module is on before installing the driver.

Use the Fn + F11 key combination (see Table D - 3, on page D - 5) to toggle power
to the Wireless LAN module (when the WLAN module is on, the  LED will
be green). Make sure you install the drivers in the order indicated in Table D - 5, on
page D - 28.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table D - 3, on
page D - 5/ Table 1 - 2, on
page 1 - 8).
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. An on-screen message will appear to show the progress of the WLAN installation.
5. When the message disappears the driver will be installed.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

3rd Party 802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Wireless Lan Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.
1. Click the taskbar wireless icon , and then double-click an access point to connect 

to or click to Open Network and Sharing Center if you do not see a network you 
want to connect to in the taskbar menu (a list of options will appear allowing setting 
changes, and creating a new network).

Network and 
Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure D - 7
Click Taskbar Icon 
Menu & Network 

and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying to
connect.

3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access

further options for the connection.
Figure D - 8

Network Location 
Set
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon ,

click the active connection and then click Disconnect (button).Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure D - 9
Click Taskbar Icon 
Menu - Disconnect
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure D - 10
Windows Mobility 

Center
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PC Camera Module (Win 7)
The PC Camera module uses the BisonCap application to capture video files. Before
installing the PC Camera driver, make sure that the optional PC Camera is on. Use
the Fn + F10 key combination (see Table D - 3, on page D - 5) to toggle power to
the PC Camera module. Make sure you install the drivers in the order indicated in
Table D - 5, on page D - 28.

Latest PC Camera 
Driver Information

Check the disc, and any ac-
companying insert pages,
for the latest updated infor-
mation on the PC Camera
driver, which may override
the information provided
here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).

PC Camera Device and TV Module

If you have both an optional PC Camera and an optional TV Tuner module present, you will
need to select which device to use with the BisonCap program. Go to the Devices menu
in the BisonCap application and select the BisonCam, NB Pro device.
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PC Camera Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc 

into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install WebCam Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the desktop, or from the 

BisonCam item in the Start > Programs/All Programs menu (if the hardware is turned off use the Fn 
+ F10 key combination to turn it on again).

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows.
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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BisonCap Application
BisonCap is a video viewer for general purpose video viewing and testing, and for
capturing video files to .avi format.

1. Run the BisonCap application from the desktop shortcut (it is recommended that 
you set the capture file before the capture process - see “Set Capture File” on 
page D - 47).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page D - 45) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Pre-Allocating File 
Size/Space

You may pre-allocate the
file size (File > Allocate
File Size/Space) for the
capture file in the camera
program (you may need
to set a folder location
first).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page D
- 47.
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Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file
name and location before capture (this will help avoid accidentally overwriting files). Set the name and location
then click Open, then set the "Capture file size:" and click OK. You can then start the capture process as on
the previous page.
Note the important information in reducing video file size below in order to save file space, and help pre-
vent system problems.

Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on the C: drive system partition.
In order to prevent system problems it is recommended that you save the captured video file to a location other
than the C: drive (see set capture file above), limit the file size of the captured video (see “Pre-Allocating File
Size/Space” on page D - 46) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:
1. Run the BisonCap application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the BisonCap application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency/Anti Flicker in Property Page (tab).

Figure D - 11
Video Capture Filter
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Zoom
The BisonCap program allows you to zoom the camera in and out.

1. Run the BisonCap application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The BisonCap program allows you to take still pictures.

1. Run the BisonCap application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop (see sidebar).

Figure D - 12
Zoom/Setting

Snapshot Folder

The Snapshot folder’s de-
fault location is on the desk-
top. Do not move this folder
or an error may appear
when you try to take a still
picture.

If you accidentally delete or
move the folder, you can
create a new Snapshot
folder on the desktop in or-
der to capture the files.
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TV Tuner Module (Win 7)
If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows 7 (not included
in Starter or Home Basic versions). A driver is provided on the Device Drivers &
Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.

TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please
do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure D - 13
TV Tuner Ports/

Jacks
1. Consumer Infra-

red Transceiver
2. CATV Antenna 

Jack 2

1
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Consumer Infrared Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install CIR Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by Windows Media Center in 

Windows 7 (not included in Starter or Home Basic versions).
2. Run Windows Media Center directly from the Start menu (Start > Win-

dows Media Center).
3. Windows Help and Support provides information on the Windows Media 

Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying glass 
icon  to bring up the results.

TV Tuner Module 
Support

Note that the TV Tuner
module options in Win-
dows 7 is supported by
the Windows Media
Center software which
comes built-in to all the
Windows 7 versions
except Starter and
Home Basic. 

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install any
Windows 7 version ex-
cept Starter and Home
Basic.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV broad-
cast signal. The passive antenna provided should provide a clear signal when placed
beside a window. If the signal is not clear then you can purchase an active antenna
(it should also be placed beside a window) to improve the signal. You should also
check with any related government website which provides information on digital
terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the
digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page D - 15)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a power
saving state, to run Windows Media Center and to navigate the Media Center menus
etc. The remote control unit also gives full control over all TV and video functions.

CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer’s attention
to Article 820-93 of the
NEC (Section 54, Part I
of the Canadian Electri-
cal Code).
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Intel Turbo Memory Module (Win 7)
If you have included an Intel Turbo Memory (Robson) NAND flash memory card
module in your purchase option, then you will need to enable AHCI or RAID mode
in the BIOS (see “Advanced Menu” on page 5 - 7) BEFORE installing the Win-
dows 7 operating system software.

Note that if you are adding an Intel Turbo Memory (Robson) NAND flash memory
card module to a computer that already has an operating system and drivers etc. in-
stalled, you will need to reinstall the OS and all necessary drivers and utilities (make
sure you back up all your important data before doing so).

Intel Turbo Memory Technology (also known as Robson flash memory) is an Intel
technology that reduces the time it takes for a computer to boot up, to load applica-
tions, and to write data to the hard drive. Intel Turbo Memory Technology is sup-
ported in Windows Vista/7 (it also supports Windows Vista/7 features such as
ReadyBoost, ReadyDrive, and Superfetch).

e-SATA Port 
Support

Note that the Intel Ma-
trix Storage driver is
required to support
the e-SATA port even if
you have not included
an Intel Turbo Memory
module in your pur-
chase configuration.

Follow the instructions
provided here in order to
install the driver.
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Intel Turbo Memory & Matrix Storage Setup and Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install TM&iMSM Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.
6. For Turbo Memory modules that support User Pinning see “Intel Turbo Memory Dashboard (User 

Pinning Supported Only)” on page D - 55.
7. For Turbo Memory modules that do not support User Pinning see“Intel Turbo Memory Console (All 

Modules)” on page D - 58.

If the Turbo Memory module supports User Pinning then the Intel Turbo Memory Dashboard will be in-
stalled. If the Turbo Memory module does not support User Pinning then the Intel Turbo Memory Dashboard
will not be installed.
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Intel Turbo Memory Dashboard (User Pinning Supported Only)
The Intel Turbo Memory Dashboard allows you to pin an application or file to load
into the Intel Turbo Memory NAND cache for performance acceleration.

1. Run the Intel® Turbo Memory Dashboard from the Programs/All Programs 
menu (Intel® Turbo Memory) or from the desktop shortcut.

2. The Pinning Capacity Consumption Meter  displays the amount of pinning
space used.

3. The Control and Profile Pull-Down Menu  allows you to select and manage
profiles. 

4. The Application Window  lists all applications available for performance
acceleration. When accelerated the applications/files will appear in the
Accelerated Window .

5. The Custom Sets Window  allows you to select specific files to be pinned. 

Help

Click the Help icon  to
bring up the menu and
click to select and help
topic.

Figure D - 14
Intel Turbo Memory 

Dashboard

1

2

3

4
5

1
2

3

4
5
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Pinning an Application (User Pinning Supported Only)
1. The Intel® Turbo Memory Dashboard allows you to select files and applications to 

accelerate and therefore open faster and display quicker.
2. Applications will be listed in the Applications Window on the right.
3. To accelerate any application drag the icon into the Accelerated pane on the left

(the available memory is indicated in the top left).
4. A status bar indicates the pinning progress and will turn green when ready.

Unpinning an 
Application

Click the application in
the Accelerated Win-
dow and drag it back to
the Applications Win-
dow to unpin the appli-
cation.

You can also unpin the
application by right-
clicking it in the Appli-
cations Window and
selecting “Remove
from Cache.”

Figure D - 15
Accelerated 
Applications
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Custom File Sets (User Pinning Supported Only)
A Custom File Set allows you to group applications and files to accelerate. These sets
can be moved easily in and out of the Accelerated Window which is of benefit when
space is limited. You need to create the custom file set before dragging the set to the
accelerated window.

1. Click Custom File Sets and type a name for the set, and then click Next.
2. Select the file set folder icon and click Advanced. 
3. Click the Browse button and select the files and applications to accelerate.
4. Click the Done button when finished.
5. Drag the custom set across to the Accelerated Window from Custom File 

Sets to accelerate.

Figure D - 16
Create Custom File 

Set
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Intel Turbo Memory Console (All Modules)
1. Run the Intel® Turbo Memory Console from the Programs/All Programs 

menu (Intel® Turbo Memory).
2. You can enable/disable Windows ReadyBoost and Windows ReadyDrive 

from the Intel® Turbo Memory Console.

• Windows ReadyBoost - uses flash memory as a hard-drive caching solution 
(Not supported if User Pinning is supported).

• Windows ReadyDrive - uses hybrid drives as a hard-drive caching solution.

Windows 
ReadyBoost

If your module supports
User Pinning (i.e. the
Intel Turbo Memory
Dashboard is installed)
then ReadyBoost is
not supported (the item
will be grayed out).

Note that the Intel Turbo
Memory Console DOES
NOT appear if you have
not included a Turbo
Memory module in your
purchase configuration.

Figure D - 17
Intel Turbo Memory 

Console
D - 58 Intel Turbo Memory Module (Win 7)



Windows 7 Information

D

Setting Up SATA RAID or AHCI Modes (Win 7)
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID
You may use your identical (see sidebar) hard disks (if you have included more than
one hard disk in your purchase option) in combination with Striping (RAID 0), Mir-
roring (RAID 1), Parity Across Disks (RAID 5) or Intel® Rapid Recover Technology
(Recovery) for fault tolerance and data recovery (see Table D - 6, on page D - 60).
To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes you
will require at least two hard disks; to configure your system in Intel® Rapid Recov-
er Technology (Recovery) mode you will require two hard disks installed; to con-
figure your system in Parity Across Disks (RAID 5) mode you will require three
hard disks installed.

Intel® Matrix Storage Manager
Make sure you install the Intel Matrix driver and application if you have set up your
hard disk(s) in AHCI or RAID modes (see “Intel® Matrix Driver Installation” on
page D - 67).

RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.
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RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

RAID 5
Identical drives (at least three drives must be used) in a parity across disks 
configuration are used to protect data and increase performance. A RAID 5 array 
can withstand a single disk failure without losing access to data.

Recovery
Two Identical drives copying data between a master and a recovery disk. This provides 
more control over how data is copied between the master and recovery drives, fast 
volume updates and the ability to view the data in Windows Explorer.

Table D - 6
RAID Levels

Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.
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Prepare the following before setting up your serial ATA hard disks in RAID mode (to configure AHCI mode
you do not need to prepare any extra hard disks but will need to install the Intel Matrix driver):

1. The Microsoft Windows OS CD.
2. A second (identical) hard disk installed in the Primary HDD bay for RAID level 0 or 1 (required for RAID but not

required for AHCI).
OR
A a second (identical) hard disk installed in the Primary HDD bay, and a third (identical) hard disk in the
Secondary HDD bay for RAID level 5.

3. The Device Drivers & Utilities + User’s Manual disc.
4. For Recovery level RAID you will also require a USB Flash drive, external USB hard disk or external USB

floppy disk drive and floppy diskette.
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SATA RAID or AHCI Setup Procedure (BIOS)
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode Selection" and press Enter (see page 5 - 8).

• Select either “RAID” or “AHCI”.

3. Press Esc and go to the Boot menu.
4. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first device in the

boot order from the Boot menu.
5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and

reboot the computer.
6. For RAID mode see the instructions in “RAID Setup (Intel Matrix)” on page D - 63.
7. For AHCI mode simply install the Intel Matrix driver after installing the OS and all other drivers listed in Chapter

4 (see “Intel® Matrix Driver Installation” on page D - 67).
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RAID Setup (Intel Matrix)
1. Press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next 

field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 or 

Recovery - see Table D - 6, on page D - 60) and then press Tab or Enter to 
advance to the next field.

5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select Create Volume.

Figure D - 18
Intel(R) Matrix 

Storage Manager 
Option ROM

Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization between
the disks to be Continu-
ous (automatic) or On
Request (manually).

RAID Volumes: * = Data is Encrypted

None Defined

Physical Disks:

Port Drive Model Serial # Size Type/Status(Vol ID)

0 FUJITSU MHY2120B K404T812P22B 111.7GB Non-RAID Disk

1 FUJITSU MHY2120B K404T7C2KJ14 111.7GB Non-RAID Disk

Intel(R) Matrix Storage Manager option ROM v8.5.0.1030 ICH10R wRAID5

Copyright (C) 2003-08 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[ ��] - Select [ESC]-Exit [ENTER]-Select Menu

1. Create RAID Volume 3. Reset Disks to Non-RAID

2. Delete RAID Volume 4. Recovery Volume Options

5. Exit
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9. Press Enter to create the volume, and confirm the selection by pressing Y.
10. This will now return to the main menu.

11. Select 5.Exit and press Enter, then press Y to exit the RAID configuration menu.
12. As the computer starts up, press a key when you see the message "Press any key to boot from CD".
13. Press Enter to continue installing the operating system as normal (see your Windows documentation if you 

need help on installing the Windows OS).
14. If you have selected a Recovery level RAID then see “Windows Installation for Recovery Level RAID 

Systems” on page D - 65.
15. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual disc as per Table 4 - 1, on 

page 4 - 3 (make sure you install the Intel Matrix driver - see “” on page D - 67).

RAID Volumes: * = Data is Encrypted

ID Name Level Strip Size Status Bootable

0 MyRAID RAID1(Mirror) N/A 111.7GB Normal Yes

Physical Disks:

Port Drive Model Serial # Size Type/Status(Vol ID)

0 FUJITSU MHY2120B K404T812P22B 111.7GB Member Disk(0)

1 FUJITSU MHY2120B K404T7C2KJ14 111.7GB Member Disk(0)

Intel(R) Matrix Storage Manager option ROM v8.5.0.1030 ICH10R wRAID5

Copyright (C) 2003-08 Intel Corporation. All Rights Reserved.

[ MAIN MENU ]

[ DISK/VOLUME INFORMATION ]

[ ��] - Select [ESC]-Exit [ENTER]-Select Menu

1. Create RAID Volume 3. Reset Disks to Non-RAID

2. Delete RAID Volume 4. Recovery Volume Options

5.Exit

Figure D - 19
RAID Created
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Windows Installation for Recovery Level RAID Systems
When you install Windows 7 for Recovery level RAID systems you will need to provide the driver for the RAID
system as per the instructions below. Firstly you will need to go to an operable computer and copy the driver
from the Device Drivers & Utilities + User’s Manual disc to a USB Flash drive, external USB hard disk or ex-
ternal floppy disk drive and floppy diskette.

1. Go to the operable computer and insert a USB Flash drive, external USB hard disk or external USB floppy disk 
drive and floppy diskette.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer.
3. Copy the RAID folder from the location below (D: denotes your DVD drive) on the Device Drivers & Utilities +

User’s Manual disc to the USB Flash drive, external USB hard disk or floppy diskette.

• D:\Win7\Others\00RAID

4. Press a key at system startup to begin installing Windows from your Microsoft Windows 7 disc. 
5. Click Install Now.
6. Make sure your USB Flash drive, external USB hard disk or external USB floppy disk drive and floppy diskette 

is attached to one of the USB ports on the computer.
7. Click “I accept the license terms” tickbox and click Next.
8. Click Custom (advanced).
9. Click to select Load Driver when the “Where do you want to install Windows?” screen appears.
10. Click Browse and browse to the location you copied the files to on your USB Flash drive, external USB hard 

disk or external USB floppy disk drive and floppy diskette (X: denotes your USB Flash drive, external USB hard 
disk or external USB floppy disk drive):

• Windows 7 32bit - X:00RAID\f6flpy32\iaStor.inf
• Windows 7 64bit - X:00RAID\f6flpy64\iaStor.inf
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11. Click Next (or format the master drive to your preferences).
12. Follow the on-screen instructions to install the Windows 7 operating system.
13. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual disc as per Table D - 5, on 

page D - 28 (make sure you install the Intel Matrix driver - see “Intel® Matrix Driver Installation” on page D - 
67).
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Intel® Matrix Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install TM&iMSM Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.

The Intel Matrix Storage Console displays status information on your RAID con-
figuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Stor-
age Manager in the All Programs menu. The Intel® Matrix Storage Manager
provides information on the RAID status.

e-SATA Port

Install the Intel Matrix
Storage driver to dis-
play the safe removal
icon for e-SATA devices
in the taskbar 

Figure D - 20
Intel Matrix Storage 

Console
(Basic & Advanced 

Views)
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Intel® Matrix Storage Manager 
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it may be possible to recover
the volume. If the volume cannot be restored then you will need to recreate the RAID volume and restore the
data from a back up. The Help menu (press F1 or select Contents and Index from the Help menu) provides
instructions on how to recover or recreate RAID Volumes.

Figure D - 21
Intel Matrix Storage 

Manager Help
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad data
on a RAID 0, RAID 1, RAID 5 or Recovery volume. The table outlines what occurs
for each RAID level:

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see “Intel Matrix
Storage Manager Help” on page D - 68.
See over for details on how to verify and repair RAID volume data.

RAID 
Level Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 1
Bad blocks are identified.
Data on the mirrored drive is compared to 
data on the source drive.

Bad blocks are reassigned.
If the data on the mirrored drive does not 
match the data on the source drive, the 
data on the mirrored drive is overwritten by 
the data on the source.

RAID 5
Bad blocks are identified.

Parity is recalculated and compared to the 
stored parity for that stripe.

Bad blocks are reassigned.

If the newly calculated parity does not 
match the stored parity, the stored parity is 
overwritten with the newly calculated parity.

Table D - 7
RAID Verification & 

Repair Status
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Verifying and Repairing RAID Volume Data
1. Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Manager 

in the Programs/All Programs menu.
2. Click View > Advanced Mode.
3. Right-click on the RAID volume and select either Verify Volume Data or Verify and

Repair Volume Data.

4. The verification or verification and repair process will run and display progress.
5. A dialog box will display the final status of the verification or verification and repair

status.

Figure D - 22
RAID Verification 

(Intel® Matrix 
Storage Console)

Figure D - 23
Verification Status
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